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Capítulo 1:  Introducción

Storyboard Pro es un software completo de creación de storyboard y animática para películas de animación, 

series de TV, proyectos que combinen 2D/3D, producciones de acción en vivo, videojuegos o eventos que 

cuenta con funciones avanzadas.

En esta Guía de introducción, aprenderá los conceptos básicos del uso de las principales funciones de 

Storyboard Pro, que le permitirán ponerse al día rápidamente. Consulte la documentación completa de Toon 

Boom Storyboard Pro disponible en línea en docs.toonboom.com para aprender acerca de todas las 

herramientas y opciones, así como sobre las técnicas avanzadas.
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Capítulo 2: Creación de un proyecto

Capítulo 2: Creación de un proyecto

Al abrir Storyboard Pro por primera vez, aparecen dos cuadros de diálogo. El primero proporciona vínculos 

para:

 l Aprender a util izar Storyboard Pro.

 l Conocer las novedades de esta versión de Storyboard Pro.

 l Participar en el foro de Toon Boom, donde puede cambiar información con otros usuarios de Storyboard 

Pro, realizar preguntas y obtener respuestas.

Al cerrar la primera pantalla de bienvenida, se mostrará la segunda, en la que se pueden crear y abrir 

proyectos.
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CONSEJO 

Una vez en la ventana principal de la aplicación, puede volver a la pantalla de bienvenida 

seleccionando Help > Show W elcome Screen (Ayuda > Mostrar pantalla de bienvenida) en el 

menú superior.

Creación de un proyecto desde la pantalla de bienvenida

 1. En el campo Project Name (Nombre de proyecto), escriba el nombre del proyecto. Este nombre se 

usará para nombrar la carpeta del proyecto y el archivo principal del proyecto.

 2. En el campo Project Title (Título del proyecto), escriba el nombre del título del proyecto. De forma 

predeterminada, este campo ya estará relleno con lo que escribió en el campo Project Name 

(Nombre del proyecto).

 3. Si desea que el proyecto tenga un subtítulo, escríbalo en el campo Project Subtitle (Subtítulo del 

proyecto). Esto no es obligatorio.

 4. En el menú desplegable Camera Size (Tamaño de cámara), seleccione la resolución del proyecto.
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Capítulo 2: Creación de un proyecto

El ancho, la altura, los fotogramas por segundo y el campo de visión se actualizan 

automáticamente en función de la selección del tamaño de la cámara.

 5. En el menú desplegable Colour Space (Espacio de color), seleccione un espacio de color para su 

proyecto.

 6. Haga clic en Create Project (Crear proyecto).
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Capítulo 3: Acerca de la interfaz de usuario

Al iniciar Storyboard Pro por primera vez, se presenta el espacio de trabajo predeterminado. Contiene todos 

los elementos principales que necesita para la creación de un storyboard.

Vistas

La interfaz de usuario de Storyboard Pro se compone principalmente de vistas, que son secciones del espacio 

de trabajo con un propósito específico y un conjunto de funciones. Cada vista tiene una pestaña encima y se 

puede anclar en la ventana de aplicación principal o hacerla flotar sobre ella en su propia ventana.

Adición de una vista al espacio de trabajo como una pestaña

 1. En la esquina superior derecha de una vista existente, haga clic en el botón  Add View (Agregar 

vista).
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Capítulo 3: Acerca de la interfaz de usuario

 2. Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestaña en la sección del espacio de trabajo donde la agregó.
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Adición de una vista a la zona de trabajo  como una ventana

 1. Abra el menú W indows (Ventanas).

 2. En el menú W indows (Ventanas), seleccione la vista que desee agregar.

La vista aparecerá como una nueva ventana sobre la ventana de la aplicación principal de 

Storyboard Pro.

Anclaje de una ventana de vista en el espacio de trabajo

 1. Haga clic y arrastre la vista flotante por la pestaña y realice una de las siguientes acciones:

 l Coloque la ventana sobre otra pestaña para agregarla a ese conjunto de pestañas.

 l Coloque la ventana por encima, por debajo o junto a una vista existente. Al acercarse 

al borde de una vista, aparece un rectángulo cian que indica dónde se anclará la vista.

Vistas de escena y de cámara

La vista de escena es la vista principal de Storyboard Pro. Se util iza para ver y editar el panel seleccionado. 

Puede dibujar en capas del panel, manipular elementos en él, y crear y visualizar movimientos de cámara.
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Capítulo 3: Acerca de la interfaz de usuario

La vista de cámara es muy parecida a la vista de escena y no es necesario usarla si no pretende trabajar en 2D. 

Sin embargo, si tiene pensado trabajar con modelos 3D, para colocar los elementos a distintas distancias de la 

cámara o rotar capas en 3D, la diferencia es importante: al trabajar en 3D, la vista de escena permite ver la 

escena desde cualquier punto de vista en el espacio 3D, mientras que la vista de cámara siempre muestra una 

vista previa de la escena desde el punto de vista de la lente de la cámara, lo que indica que representa con 

precisión lo que aparecerá al exportar el storyboard.

Panel de capas

El panel de capas aparece en una sección situada a la derecha tanto de la vista de escena como de la de 

cámara. Permite agregar, eliminar, duplicar, agrupar, reordenar, ocultar, mostrar, bloquear o desbloquear 

capas, habilitar o deshabilitar animación en capas, cambiar la opacidad de una capa y seleccionar en qué capa 

se debe dibujar, manipular o animar.
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Vista de imágenes en miniatura

La vista de imágenes en miniatura muestra todos los paneles del storyboard en orden cronológico de izquierda 

a derecha. Mediante esta vista, puede desplazarse por el storyboard, reorganizar paneles y escenas, y 

seleccionar qué panel se debe mostrar en las vistas de escena o de cámara.

Vista de línea de tiempo

La vista de línea de tiempo es la vista que se debe usar en lugar de la de imágenes en miniatura cuando desee 

crear una animática. Una animática es un vídeo basado en el storyboard, en el que cada panel está 
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Capítulo 3: Acerca de la interfaz de usuario

sincronizado para que aparezca aproximadamente durante la acción que representa, y en el cual se animan los 

movimientos de la cámara, para servir como base para el tiempo en la película. Al igual que la vista de 

imágenes en miniatura, la vista de línea de tiempo le permite crear y gestionar paneles y escenas. También le 

permite, entre otras cosas, decidir cuánto tiempo tardan cada escena y cada panel en la animática, animar los 

movimientos de cámara, animar capas y agregar clips de sonido, imágenes y vídeos en la animática.

Vista de panel

La vista de panel muestra la información básica sobre el panel seleccionado. También permite ver y editar 

cuadros de texto en el panel actual, así como agregar bocetos o anotaciones de voz al panel.
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Vista de storyboard

La vista de storyboard muestra información básica sobre el proyecto. También permite escribir, importar, ver y 

editar el guion del storyboard.
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Capítulo 3: Acerca de la interfaz de usuario

Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contiene las opciones y operaciones disponibles para la herramienta 

seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas de herramientas, la 

vista de propiedades de la herramienta se actualiza para mostrar sus opciones disponibles.

Barras de herramientas

La interfaz de Storyboard Pro contiene barras de herramientas que proporcionan acceso rápido a muchas 

herramientas útiles. Puede agregar, mover y eliminar barras de herramientas de la zona de trabajo.

Las barras de herramientas más importantes de Storyboard Pro son las de herramientas, storyboard y 

reproducción.

Barra de herramientas de herramientas

La barra de herramientas de herramientas contiene las herramientas principales que necesita para trabajar en 

Storyboard Pro. En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en el borde 

izquierdo de la ventana de la aplicación.
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Barra de herramientas de storyboard

La barra de herramientas Storyboard contiene todos los comandos básicos relacionados con la adición y 

eliminación de paneles, escenas y transiciones, así como el cambio entre las zonas de trabajo 2D y 3D.

En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en la parte superior de la 

interfaz.

Barra de herramientas de reproducción

La barra de herramientas de reproducción permite reproducir el storyboard. Al crear una animática con 

transiciones y sonido, puede reproducirla en tiempo real en la vista de escena para comprobar el tiempo.

En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en la parte superior de la 

interfaz.
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Capítulo 3: Acerca de la interfaz de usuario

Menú superior

El menú superior contiene la mayoría de los comandos disponibles en Storyboard Pro. Según la vista en la que 

esté trabajando y el elemento seleccionado, algunos comandos están disponibles y otros no. El menú superior 

siempre está situado en la parte superior de la interfaz.

Aquí se proporciona una breve introducción sobre el objetivo de cada menú en el menú superior:

Menú Descripción

Storyboard Pro 22
Permite acceder al cuadro de diálogo About (Acerca de nosotros) y también al cuadro de 

diálogo Preferences (Preferencias). Este menú solo está disponible en macOS.

File (Archivo)
Contiene elementos relacionados con la creación, el almacenamiento, la exportación y la 

importación de los proyectos.

Edit (Editar)

Contiene comandos para cortar, copiar y pegar paneles o capas seleccionados, para 

seleccionar paneles o capas, y para agrupar o desagrupar capas. En W indows, también es 

la ubicación del menú Preferences (Preferencias).

View (Vista)

Permite panear, hacer zoom o rotar la vista actual, restablecerla a su punto de vista 

predeterminado, y habilitar y deshabilitar determinados modos de vista, como el papel 

cebolla o la mesa de luz.

Play (Reproducir)
Permite reproducir y pausar la animática, así como desplazarse por los paneles y las 

escenas del storyboard.

Storyboard

Permite gestionar las escenas, paneles y secuencias del proyecto, agregar transiciones, 

marcadores, instantáneas, y trazar los cambios realizados al proyecto. También es donde 

se puede acceder al cuadro de diálogo Project Properties (Propiedades del proyecto).

Layer (Capa)
Contiene una amplio conjunto de comandos para gestionar las capas de dibujo en el panel 

actual, así como los efectos que puede aplicar a las capas.
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Menú Descripción

Camera (Cámara)
Contiene varios comandos para ayudar a gestionar la posición y la animación de la cámara 

en una escena.

Clips Contiene comandos para editar y obtener vistas previas de vídeo y clips de sonido.

Caption (Cuadro de 

texto)
Permite agregar, eliminar, buscar y establecer el formato para los cuadros de texto.

Tools 

(Herramientas)

Permite seleccionar una de las herramientas de la barra de herramientas de herramientas, 

así como ordenar, transformar y convertir las formas y líneas que componen los dibujos.

W indows 

(Ventanas)

Permite cambiar entre espacios de trabajo, administrar espacios de trabajo y acceder a las 

distintas vistas y barras de herramientas disponibles en Storyboard Pro.

Help (Ayuda)

Permite acceder a la documentación, los foros de Toon Boom, participar o dejar de 

participar en el programa de mejora de la experiencia del cliente, así como comprobar si 

existen actualizaciones. En W indows, también puede acceder al cuadro de diálogo About 

(Acerca de nosotros).

Desplazamiento por la interfaz

Con la ayuda de comandos de menú y los atajos de teclado, algunas vistas permiten navegar por su contenido 

al acercarlos, alejarlos, panearlos y rotarlos. También puede restablecer el nivel de zoom, el paneo y el ángulo 

de rotación de estas vistas según sea necesario.

Los comandos de navegación de la tabla que se muestra a continuación se pueden util izar en las siguientes 

vistas, con algunas excepciones:

 l Escena

 l Cámara

 l Línea de tiempo

 l Función, editor

 l Lateral y superior
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Capítulo 3: Acerca de la interfaz de usuario

CONSEJO 

Los atajos de teclado se pueden personalizar. Puede ver, buscar y cambiar atajos de teclado para 

Storyboard Pro en el cuadro de diálogo Keyboard Shortcuts (Atajos de teclado). Para acceder al 

cuadro de diálogo Keyboard Shortcuts (Atajos de teclado):

 l W indows : en el menú superior, seleccione Edit > Keyboard Shortcuts (Editar > Atajos de 

teclado).

 l macOS : En el menú superior, seleccione Storyboard Pro 22 > Keyboard Shortcuts 

(Storyboard Pro 22 > Atajos de teclado).

Comando Acción Métodos de acceso

Zoom In (Acercar) Acerca la vista. 

View > Zoom In (Ver > Acercar)

Pulse 2

Gire la rueda del ratón hacia arriba (excepto en las vistas de línea 

de tiempo y de vista).

Zoom Out (Alejar) Aleja la vista.

View > Zoom Out (Ver > Alejar)

Pulse 1

Gire la rueda del ratón hacia abajo (excepto en las vistas de línea 

de tiempo y de vista).

Zoom In o Zoom 

Out (Acercar o 

Alejar)

Acerca o aleja la 

vista.

Gire la rueda central del ratón hacia arriba o hacia abajo.

Mantenga pulsada la barra espaciadora y la rueda central del 

ratón mientras arrastra el ratón hacia arriba o hacia abajo.

Pan (Panear)

Mueve la vista 

horizontal o 

verticalmente.

Mantenga pulsada la barra espaciadora y arrastre en la dirección 

que desee panear la vista.

Reset Pan 

(Restablecer 

paneo)

Restablece el paneo 

de vista a su posición 

predeterminada.

View > Reset Pan (Ver > Restablecer paneo)

Pulse Mayús + N.

Reset View 

(Restablecer vista)

Restablece la vista a 

su posición 

predeterminada.

View > Reset View (Ver > Restablecer vista)

Pulse Mayús + M.

El botón Reset View (Restablecer vista)  en la parte inferior 

de las vistas de escena y de cámara.
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Comando Acción Métodos de acceso

Reset Rotation 

(Restablecer 

rotación)

Restablece la 

rotación de vista a su 

posición 

predeterminada.

View > Reset Rotation (Ver > Restablecer rotación)

Pulse Mayús + X.

Reset Zoom 

(Restablecer 

zoom)

Restablece el zoom 

de vista a su posición 

predeterminada.

View > Reset Zoom (Ver > Restablecer zoom)

Pulse Mayús + Z.

Rotate View (Rotar 

vista)

Rota la vista  a la 

izquierda o a la 

derecha.

Mientras mantiene pulsadas las teclas Ctrl + Alt (W indows) o ⌘  

+ Alt (macOS), haga clic y arrastre el disco de rotación para 

rotarlo a la derecha o a la izquierda.

3D Rotate View 

(Rotar vista 3D)

Rota la vista en 

cualquier dirección. 

Esta opción solo está 

disponible en la vista 

de escena, si la 

escena está 

habilitada para 3D.

Mientras mantiene pulsada la tecla Ctrl + Mayús (W indows) o 

mayúsculas + ⌘  (macOS), haga clic y arrastre la escena para 

rotarla en cualquier dirección.

Rotate 30 CW  

(Rotar 30 der.)

Rota la vista de 

cámara 30 grados a 

la derecha, como una 

mesa de animación.

View > Rotate View CW  (Ver > Rotar 30 der.)

Pulse V.

Rotate 30 CCW  

(Rotar 30 izq.)

Rota la vista de 

cámara 30 grados a 

la izquierda, como 

una mesa de 

animación.

View > Rotate View CCW  (Ver > Rotar 30 izq.)

Pulse C.

Toggle Full Screen 

(Alternar pantalla 

completa)

Alterna entre hacer 

que la ventana 

principal de la 

aplicación se muestre 

en pantalla completa 

y restaurarla a su 

tamaño original.

View > Toggle Full Screen (Ver > Alternar pantalla completa)

Ctrl + Alt + Mayús + F (W indows) o ⌘  + Alt + mayúsculas + F 

(macOS)
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Capítulo 4: Adición de escenas y paneles

Capítulo 4: Adición de escenas y paneles

La estructura básica de un storyboard consta de escenas, y cada una de ellas está compuesta por uno o varios 

paneles. Un panel es un dibujo que representa una acción en el guion. Los paneles y las escenas de un 

storyboard se ordenan en orden cronológico, de izquierda a derecha.

Un proyecto de animación suele requerir la creación de una nueva escena cada vez que se necesite cambiar el 

layout. Esto significa que, por ejemplo, debe crear una nueva escena en el storyboard cada vez que un cambio 

en el ángulo de la cámara requiera que se util ice un dibujo o representación diferente del fondo, así como cada 

vez que el guion lleve la acción a un entorno diferente.

Puede crear la estructura básica del storyboard agregando una escena para cada escena que requiera el guion 

y, a continuación, agregando un panel para cada acción en cada escena que se debe representar visualmente.

NOTA 

En la terminología de acción en vivo, esta definición de escena se conoce como plano. Una escena 

de acción en vivo es en realidad una secuencia de planos que se producen en la misma 

configuración.

Si está trabajando en un storyboard destinado a una película de acción en vivo, puede hacer que 

Storyboard Pro util ice terminología de acción en vivo seleccionando la opción de estilo de 

terminología Live Action (Acción en vivo) en la pestaña General del cuadro de diálogo Preferences 

(Preferencias). Para facilitar la comprensión, esta guía util izará principalmente la terminología de 

animación.

Creación de escenas

Un nuevo proyecto contendrá una escena con un solo panel. La creación de una nueva escena siempre se 

realizará automáticamente con un panel.

Adición de una escena al storyboard

 1. Seleccione cualquier panel de la última escena del storyboard.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas de storyboard, haga clic en el botón New Scene (Nueva 

escena).

 l Haga clic con el botón derecho en un panel y seleccione New Scene (Nueva escena).

 l En el menú superior, seleccione Storyboard > New > New Scene (Storyboard > Nuevo > 

Nueva escena).
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Después de la escena actual, se agrega una nueva escena que contiene un panel en blanco.

Cada escena tiene un número asignado. Al crear una escena al final del proyecto, Storyboard Pro le asigna 

automáticamente el número que aparece justo después del número de la última escena. Si intenta insertar una 

escena entre dos escenas existentes, se le pedirá que indique cómo debe nombrarse esta nueva escena y si las 

escenas posteriores a la nueva deben volver a numerarse.

Inserción de una escena entre dos escenas existentes

 1. Seleccione cualquier panel de la escena después del cual se deba insertar la nueva escena.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas de storyboard, haga clic en el botón New Scene (Nueva 

escena).

 l Haga clic con el botón derecho en un panel y seleccione New Scene (Nueva escena).

 l En el menú superior, seleccione Storyboard > New > New Scene (Storyboard > Nuevo > 

Nueva escena).

Aparece el cuadro de diálogo Rename Scene (Cambiar nombre de escena).
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Capítulo 4: Adición de escenas y paneles

 3. Realice una de las siguientes acciones:

 l Si desea que la nueva escena tenga un sufijo para indicar que se insertó entre las escenas 

existentes, no tiene que editar ninguno de los campos. El campo New name (Nuevo nombre) 

ya contiene el nombre de la escena seleccionada actualmente seguida de un sufijo de letra. 

Por ejemplo, si ha intentado insertar una escena antes de las escenas 2 y 3, Storyboard Pro 

nombrará la nueva escena 2_A de manera predeterminada.

 l Si desea que la escena tenga el número después del número de la escena seleccionada y 

vuelva a numerar todas las escenas siguientes en consecuencia, introduzca este número en 

el campo New Name (Nuevo nombre). Por ejemplo, si va a insertar una escena entre las 

escenas 2 y 3, escriba 3 en el campo New Name (Nuevo nombre). A continuación, en el 

menú desplegable Renaming Rule for Subsequent Scene (Cambiar nombre de regla para 

escena posterior), seleccione Renumber Scenes (Volver a numerar escenas).

 4. Si tiene la intención de util izar las mismas opciones cada vez que inserte una escena, active la 

opción Do not show this dialog automatically (No mostrar este cuadro de diálogo 

automáticamente).

 5. Haga clic en OK (Aceptar).

Después de la escena actual, se agrega una nueva escena que contiene un panel en blanco, 

numerado de acuerdo con la configuración seleccionada.

Creación de paneles

Un panel se util iza para representar visualmente una acción en una escena. Debe agregar tantos paneles a una 

escena como sea necesario para describir explícitamente cada acción de esa escena.

Adición de un panel a una escena

 1. En la vista de imágenes en miniatura, seleccione el panel después del cual desea insertar un nuevo 

panel.

 2. Realice una de las siguientes acciones:
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 l En la barra de herramientas de storyboard, haga clic en el botón New Panel (Nuevo 

panel) .

 l En el menú superior, seleccione Storyboard > New > New Panel 

 l Pulse P.

Se agrega un nuevo panel al storyboard y forma parte de la misma escena que el panel actual.

Creación de secuencias

Una secuencia es una forma de agrupar escenas. Su uso es opcional, pero pueden ayudarle a organizar el 

storyboard. Por ejemplo, puede util izar secuencias para agrupar escenas que forman parte de la misma 

configuración.

Al comenzar a crear un storyboard, las escenas no formarán parte de ninguna secuencia de manera 

predeterminada. Para util izar secuencias en el proyecto, puede aplicar uno de los dos enfoques siguientes:

 l Después de haber creado todas las escenas que deben formar parte de la primera secuencia, solo tiene 

que usar el comando New Sequence (Nueva secuencia) para crear la próxima escena. Todas las 

escenas que se encuentren en el proyecto se agruparán en la primera secuencia de este y, al final del 

proyecto, se agregará una nueva escena que iniciará la segunda secuencia.

A partir de ese punto, puede util izar el comando New Sequence (Nueva secuencia) cada vez que tenga 

que crear una escena que deba iniciar otra secuencia.

 l Después de haber creado todas las escenas necesarias para el proyecto, puede dividir el storyboard en 

secuencias seleccionando las escenas que deben formar parte de la misma secuencia, agrupándolas en 

una nueva secuencia y repitiendo el proceso hasta que todas las escenas se encuentren en la secuencia 

adecuada.
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Creación de una nueva secuencia

 1. Realice una de las siguientes acciones:

 l En la barra de herramientas de storyboard, haga clic en el botón New Sequence (Nueva 

secuencia) .

 l En el menú superior, seleccione Storyboard > New > New Sequence (Storyboard > Nuevo > 

Nueva secuencia).

Se ha agregado una nueva escena al proyecto y ahora es el punto de inicio de una nueva secuencia.

Si esta es la primera secuencia que agrega a un proyecto, todas las escenas anteriores se 

combinarán en una secuencia independiente. Los marcadores de secuencia violetas también serán 

visibles en las vistas de imágenes en miniatura y de línea de tiempo.

Creación de una nueva secuencia a partir de una selección

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione todas las escenas que desee 

colocar en una nueva secuencia. Para ello, mantenga pulsada la tecla Mayús y haga clic en la 

primera escena que debe formar parte de la nueva secuencia y, a continuación, haga clic en la 

última escena con el mismo propósito. Con esta acción se seleccionan todas las escenas situadas 

entre las que ha hecho clic.

 2. Realice una de las siguientes acciones:

 a. En el menú superior, seleccione Storyboard > New > New Sequence from Selection 

(Storyboard > Nuevo > Nueva secuencia de selección).
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 b. Haga clic con el botón derecho en la selección y, a continuación, seleccione New Sequence 

from Selection (Nueva secuencia de selección).

La selección se convierte en una nueva secuencia.

Si esta es la primera secuencia que agrega al proyecto, todas las escenas anteriores a la selección 

se agruparán en una secuencia independiente, y todas las escenas posteriores a la selección se 

agruparán en otra secuencia. Los marcadores de secuencia violetas serán visibles en las vistas de 

imágenes en miniatura y de línea de tiempo.

NOTA 

Las secuencias deben incluir escenas completas. Si solo selecciona algunos de los paneles de 

una escena, se incluirá toda la escena en la secuencia.

Reordenación de paneles

Puede reordenar paneles haciendo clic en el controlador de arrastrar y colocar  situado en la esquina superior 

izquierda del panel y, a continuación, arrastrando el panel entre los dos paneles donde desea que se muevan. 

Aparecerá una línea roja entre los dos paneles cerca del cursor del ratón para indicar el lugar al que se moverá 

el panel.
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CONSEJO 

Si desea mover varios paneles a la vez, puede seleccionarlos y, a continuación, hacer clic y 

arrastrar el controlador de arrastrar y colocar de cualquier panel de la selección. Para seleccionar 

varios paneles en la vista de imágenes en miniatura, realice una de las siguientes acciones:

 l Dibuje un rectángulo en la vista de imágenes en miniatura alrededor de todos los paneles que 

desee seleccionar.

 l Mientras mantiene pulsada la tecla Mayús, haga clic en el primer panel que desee agregar a la 

selección y, a continuación, en el último panel que desee agregar. Todos los paneles 

intermedios también se seleccionarán.

 l Mientras mantiene pulsada la tecla Ctrl (W indows) o ⌘  (macOS), haga clic en cada panel que 

desee agregar a la selección.

Si mueve un panel al espacio situado entre dos escenas, puede colocar el panel en la escena anterior o 

posterior a este espacio, o bien colocarlo en su propia escena nueva. El lugar donde terminará la escena 

dependerá de lo cerca que coloque el panel. La línea roja que aparece entre las dos escenas indicará si se 

colocará en la escena anterior o posterior al espacio en el que se vaya a colocar el panel, o si se moverá a su 

propia escena nueva.
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Antes de crear un storyboard, debe tener preparado un guion. Puede escribir el guion del proyecto 

directamente en Storyboard Pro o puede importarlo desde un archivo. A continuación, puede separar el guion 

en cuadros de texto para cada uno de los paneles del storyboard para proporcionar al artista del storyboard la 

información necesaria para dibujar el contenido de cada panel.

De forma predeterminada, cada panel puede almacenar cuatro tipos de cuadros de texto distintos: Dialogue 

(Diálogo), Action Notes (Notas de acción), Slugging y Notes (Notas). Los tipos Dialogue (Diálogo) y Action 

Notes (Notas de acción) se pueden obtener directamente del guion, y Notes (Notas) se puede util izar para 

almacenar información como encabezados de escena, transiciones y otra información útil. Los cuadros de texto 

de Slugging se suelen agregar más tarde, mientras se crea el storyboard, para proporcionar indicaciones de 

tiempo sobre los diálogos y acciones para la animática.

Escritura de un guion

Puede escribir el guion del storyboard directamente en la vista de storyboard.

Escritura del guion en el proyecto de Storyboard Pro

 1. Abra la vista de storyboard. De forma predeterminada, estará en el panel derecho de la zona de 

trabajo.

 2. Haga clic en el interior del campo de texto.

 3. Comience a escribir el guion.
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Storyboard Pro comprueba la ortografía de las palabras que escribe en la vista de storyboard, así como en los 

campos de cuadro de texto de la vista de panel, con el diccionario de un idioma específico. Puede cambiar el 

idioma del corrector ortográfico al idioma en el que está escribiendo.

NOTA 

De forma predeterminada, la corrección ortográfica se realiza en inglés (EE. UU.) si Storyboard Pro 

se inicia por primera vez en inglés, y en español (ES) si Storyboard Pro se inicia por primera vez en 

español.

Si se inicia Storyboard Pro por primera vez en chino o japonés, no se seleccionará ningún 

diccionario de forma predeterminada y tendrá que seleccionar un diccionario para habilitar el 

corrector ortográfico. Storyboard Pro no tiene diccionarios en chino y japonés.

Cambio del diccionario utilizado para el control de ortografía automático

 1. En el menú superior, seleccione Captions > Spelling > Spell Check (Cuadros de texto > Ortografía 

> Corrector ortográfico).

Aparece el cuadro de diálogo Spelling (Ortografía).

 2. En la lista desplegable Language (Idioma) situada en la parte inferior, seleccione el idioma en el 

que desea escribir el guion:

 l English (AU): Inglés (Australia)

 l English (US): Inglés (Estados Unidos)

 l English (CA): Inglés (Canadá)

 l English (GB): Inglés (Reino Unido)
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 l Español (ES): Español (España)

 l Français (FR): Francés (Francia)

 l 한국어 (KR): Coreano

 l Português (BR): Portugués (Brasil)

 l Português (PT): Portugués (Portugal)

 l русский (RU): Ruso

 l No Spellchecking (Sin corrección ortográfica): Deshabilita la corrección ortográfica

La corrección ortográfica automática se hará ahora con el diccionario seleccionado.

 3. Haga clic en Close (Cerrar).

Corrector ortográfico

En cualquier momento, mientras escribe el guion o rellena los cuadros de texto del proyecto o después de 

hacerlo, puede util izar el cuadro de diálogo Spelling (Ortografía) para revisar y corregir los errores ortográficos 

que detecte el corrector ortográfico de Storyboard Pro.

El cuadro de diálogo Spelling (Ortografía) revisará todos los errores de ortografía que pueda encontrar en el 

proyecto, incluso en el guion y los cuadros de texto del panel. Comenzará a buscar errores ortográficos por el 

campo de texto seleccionado en la posición en la que se encuentra el cursor de escritura.

Corrección de errores ortográficos en el guion o los cuadros de texto del proyecto

 1. Coloque el cursor de escritura donde desee comenzar a comprobar los errores de ortografía:

 l Si desea revisar la ortografía de todo guion, abra la vista de storyboard y haga clic en el 

campo Script (Guion), cerca de la esquina superior izquierda, para colocar el cursor de 

escritura al principio del guion.
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 l Si desea revisar la ortografía de todos los cuadros de texto del proyecto, seleccione el primer 

panel del proyecto en la vista de imágenes en miniatura o de línea de tiempo, abra la vista 

de panel y, a continuación, haga clic dentro del primer campo de cuadro de texto, cerca de la 

esquina superior izquierda, para colocar el cursor de escritura al principio de este cuadro de 

texto.

 l Si desea revisar la ortografía de un cuadro de texto específico del proyecto, seleccione el 

panel que contenga ese cuadro de texto en la vista de imágenes en miniatura o de línea de 

tiempo, abra la vista de panel y, a continuación, haga clic dentro del campo de cuadro de 

texto que desea comprobar, cerca de la esquina superior izquierda, para colocar el cursor de 

escritura al principio de este cuadro de texto.

 l Si solo desea ver las sugerencias de ortografía para una palabra mal escrita específica, 

únicamente tiene que resaltar esa palabra.
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 2. En el menú superior, seleccione Captions > Spelling > Spell Check (Cuadros de texto > Ortografía 

> Corrector ortográfico).

Aparece el cuadro de diálogo Spelling (Ortografía). La primera palabra que encuentre en el guion o 

en el cuadro de texto que no exista en su diccionario se seleccionará en la vista de storyboard o de 

panel. También aparecerá en el cuadro de diálogo Spelling (Ortografía), junto a la etiqueta 

Unknown W ord: (Palabra desconocida:).

Las sugerencias sobre cómo corregir la palabra, si existe alguna, se enumerarán en la lista 

siguiente. Se seleccionará la primera sugerencia de la lista y también aparecerá en el campo 

Replace W ith: (Sustituir por:).

 3. Para cada error de ortografía recogido en el cuadro de diálogo Spelling (Ortografía), realice una de 

las siguientes acciones:

 l Para corregir esta palabra en concreto, seleccione la palabra correcta en la lista de 

sugerencias de ortografía o escriba la palabra correcta en el campo Replace W ith: (Sustituir 

por:) y haga clic en Replace Once (Sustituir una vez).

 l Para reemplazar todas las palabras escritas de esta manera en el proyecto por la palabra 

correcta, seleccione la palabra correcta en la lista de sugerencias de palabras o escriba la 

palabra correcta en el campo Replace W ith: (Sustituir por:) y, a continuación, haga clic en 

Replace All (Sustituir todos).

NOTA 

Se reemplazará la palabra seleccionada del guion y todos los cuadros de texto 

del proyecto.

 l Para omitir la corrección de esta palabra y pasar al siguiente error ortográfico, haga clic en 

Skip (Omitir).
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 l Para ignorar los casos de esta palabra escrita de esta manera específica, haga clic en Ignore 

All (Ignorar todo).

NOTA 

Storyboard Pro ignorará todas las coincidencias de este error ortográfico durante 

el resto de la sesión. La próxima vez que inicie Storyboard Pro, volverá a detectar 

este error ortográfico. 

 l Si la palabra está bien escrita y no desea que se muestre en el cuadro de diálogo Spelling 

(Ortografía) en el futuro, haga clic en Add to Dictionary (Agregar al diccionario). La palabra 

se agregará al diccionario personal para evitar que Storyboard Pro la considere un error 

ortográfico en el futuro.

Cada vez que realice una acción sobre un error ortográfico, el cuadro de diálogo Spelling 

(Ortografía) pasará inmediatamente al siguiente error ortográfico que encuentre a medida que pase 

por el guion y los cuadros de texto del proyecto. 

Una vez que se hayan corregido todos los errores ortográficos, en el campo Unknown W ord: 

(Palabra desconocida:) aparecerá No errors found (No se han encontrado errores).

 4. Una vez que haya terminado de revisar la ortografía del proyecto, haga clic en Close (Cerrar).

Importación de un guion

Puede importar un guion en texto sin formato (.txt), formato de texto enriquecido (.rtf) o en un archivo 

XML de Final Draft (.fdx) directamente en el campo Script (Guion) de la vista de storyboard. También puede 

copiarlo y pegarlo desde el editor, o escribirlo directamente en la vista de storyboard.

Importación de un guion en un proyecto de Storyboard Pro

 1. En la vista de storyboard, haga clic en el botón Menu (Menú)  situado sobre el lado derecho del 

campo de texto y:

 l Si el guion está en texto sin formato (.txt) o en formato de texto enriquecido (.rtf), 

seleccione Import Caption (Importar cuadro de texto).

 l Si el guion está en formato XML de Final Draft (.fdx), seleccione Import Final Draft Script 

(Importar guion de Final Draft).

 2. En el buscador de archivos, localice y seleccione el archivo de guion y haga clic en Open (Abrir).

El guion aparece en el campo de cuadro de texto Script (Guion).
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Adición de cuadros de texto

Una vez importado el guion, puede crear la estructura básica del storyboard creando escenas y paneles vacíos 

en función de los encabezados de escena, acciones y diálogos del guion, y, a continuación, rellenando los 

campos de cuadro de texto de cada panel del storyboard con información del guion.

Para ello, puede seleccionar un fragmento del guion en la vista de storyboard y, a continuación, puede 

arrastrarlo y colocarlo en un campo de cuadro de texto en la vista de panel, copiando al instante el texto 

seleccionado en el campo de cuadro de texto del panel actual.

NOTA 

Para aprender a crear escenas y paneles, consulte Adición de escenas y paneles en la página 22.

Cómo arrastrar y colocar texto desde el guion en campos de cuadro de texto

 1. Cambie a la zona de trabajo vertical mediante una de las siguientes acciones:

 l En la barra de herramientas de zona de trabajo, haga clic en el botón Vertical W orkspace 

(Zona de trabajo vertical) .

 l En el menú superior, seleccione W indows > W orkspace > W orkspace > Vertical (Ventanas 

> Zona de trabajo > Zona de trabajo > Vertical).
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 2. En el panel derecho de la zona de trabajo, seleccione la pestaña Storyboard.

La zona de trabajo tiene ahora una lista vertical de cada panel del storyboard a la izquierda, con sus 

campos de cuadro de texto correspondientes en el centro y el guion del storyboard a la derecha.

 3. En la vista de imágenes en miniatura, desplácese al panel en el que desee agregar cuadros de 

texto.

 4. En el campo de cuadro de texto Script (Guion) de la vista de storyboard, seleccione la parte del 

guion que desea agregar a un cuadro de texto del panel.

 5. En el cuadro de texto Script (Guion), arrastre el texto seleccionado y colóquelo en el campo de 

cuadro de texto adecuado del panel.

 6. Repítalo hasta que haya copiado todo el texto necesario para cada uno de los paneles en sus 

campos de cuadro de texto.
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CONSEJO 

También puede arrastrar y colocar texto desde cualquier cuadro de texto del panel a 

otro cuadro de texto del panel, o desde un cuadro de texto del panel al guion.

 7. Una vez que haya terminado, puede restaurar la zona de trabajo que estaba util izando 

seleccionándola desde la barra de herramientas de zona de trabajo o desde el menú superior. Por 

ejemplo, la zona de trabajo predeterminada es Drawing W orkspace (Zona de trabajo de dibujo). 

Para restaurar esta zona de trabajo, realice una de las siguientes acciones:

 l En la barra de herramientas de zona de trabajo, haga clic en el botón Drawing W orkspace 

(Zona de trabajo de dibujo) .

 l En el menú superior, seleccione W indows > W orkspace > Drawing (Ventanas > Zona de 

trabajo > Dibujo). 

Creación de un proyecto a partir de un guion de Final Draft

Si el guion se ha escrito en Final Draft, puede generar automáticamente un proyecto con escenas, paneles 

vacíos y cuadros de texto previamente rellenos basados en la estructura del guion. Por ejemplo, puede 

generar un proyecto con una nueva escena para cada encabezado de escena y un nuevo panel para cada 

acción o diálogo, y almacenar el contenido de estos párrafos en los campos de cuadro de texto de sus paneles, 

lo que le permite iniciar el proceso de creación de storyboard.

Creación de un proyecto a partir de un guion de Final Draft

 1. En el menú superior, seleccione File > New From Final Draft Script (Archivo > Nuevo desde guion 

de Final Draft).

Se abre el cuadro de diálogo Import from Final Draft (Importar de Final Draft).

 2. Haga clic en el botón Browse (Examinar) .

 3. En el explorador de archivos, localice y seleccione el guion de Final Draft y haga clic en Open 

(Abrir).

Una vez cargado el guion, los tipos de etiquetas que figuran en el guion aparecerán en la lista de la 

izquierda. Tendrá que indicar a Storyboard Pro qué hacer con cada una de estas etiquetas al 

generar el proyecto.
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 4. En la lista de la izquierda, seleccione Scene Heading (Encabezado de escena):

 a. En el menú desplegable Acción (Acción), seleccione New Scene (Nueva escena).

 b. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 

seleccione Notes (Notas).

 c. Si los elementos de Scene Heading (Encabezado de escena) están numerados en el guion y 

desea incluir su número en los cuadros de texto del proyecto, marque la opción Include 

Element Number when available (Incluir número de elemento cuando esté disponible).

El storyboard dispondrá de una escena para cada encabezado de escena del guion, y la descripción 

de la escena se agregará al cuadro de texto Notes (Notas) del primer panel de cada escena.

 5. En la lista de la izquierda, seleccione la etiqueta Action (Acción) y, a continuación:

 a. Si desea que se cree un panel para cada acción, seleccione New Panel (Nuevo panel) en la 

lista desplegable Action (Acción). 
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 b. Si desea combinar acciones consecutivas en el mismo panel, active la opción Combine 

successive elements (Combinar elementos sucesivos).

 c. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 

seleccione Action Notes (Notas de acción). Esta acción almacenará el contenido de la 

etiqueta de acción en el cuadro de texto Action Notes (Notas de acción) de cada panel. 

 d. Si los elementos de Action (Acción) están numerados en el guion y desea incluir su número 

en los cuadros de texto del proyecto, marque la opción Include Element Number when 

available (Incluir número de elemento cuando esté disponible).

 6. En la lista de la izquierda, seleccione la etiqueta Character (Personaje), si la hubiera y, a 

continuación:

 a. Si desea que se cree un panel para cada diálogo, seleccione New Panel (Nuevo panel) en la 

lista desplegable Action (Acción). 

 b. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 

seleccione Dialogue (Diálogo).

 c. Si los elementos de Character (Personaje) están numerados en el guion y desea incluir su 

número en los cuadros de texto del proyecto, marque la opción Include Element Number 

when available (Incluir número de elemento cuando esté disponible).

 7. En la lista de la izquierda, seleccione la etiqueta Parenthetical (Paréntesis), si la hubiera y, a 

continuación:

 a. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 

seleccione Dialogue (Diálogo).
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 b. Si los elementos de Parenthetical (Paréntesis) están numerados en el guion y desea incluir 

su número en los cuadros de texto del proyecto, marque la opción Include Element Number 

when available (Incluir número de elemento cuando esté disponible).

 8. En la lista de la izquierda, seleccione la etiqueta Dialogue (Diálogo), si la hubiera:

 a. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 

seleccione Dialogue (Diálogo). 

 b. Si los elementos de Dialogue (Diálogo) están numerados en el guion y desea incluir su 

número en los cuadros de texto del proyecto, marque la opción Include Element Number 

when available (Incluir número de elemento cuando esté disponible).

 9. En la lista de la izquierda, seleccione la etiqueta Transition (Transición), si la hubiera:

 a. En la lista desplegable Action (Acción), seleccione New Transition (Nueva transición). 

En general, se sugieren los siguientes ajustes:

  Action (Acción) 
Destination caption field (Campo 

de cuadro de texto de destino)

Action (Acción) New Panel (Nuevo panel) Action Notes (Notas de acción)

Character (Personaje) New Panel (Nuevo panel) Dialogue (Diálogo)

Dialogue (Diálogo) None (Ninguno) Dialogue (Diálogo)

Parenthetical (Paréntesis) None (Ninguno) Dialogue (Diálogo)

Scene Heading (Encabezado 

de escena)
New Scene (Nueva escena) Notes (Notas)

Transition (Transición)
New Transition (Nueva 

transición)
None (Ninguno)

40



NOTA 

Dependiendo de la forma en la que esté estructurado el guion y del ritmo de la acción o 

el diálogo, es posible que tenga que intentar crear un proyecto con el guion util izando 

distintas opciones para obtener la mejor estructura de storyboard según sus 

necesidades. Al final, es probable que tenga que dividir o combinar algunos de los 

paneles generados automáticamente.

 10. Si desea que los parámetros seleccionados actualmente sean los predeterminados, active la casilla 

de verificación Save as default rules (Guardar como reglas predeterminadas).

 11. Haga clic en Import (Importar).

Aparece el cuadro de diálogo New Project (Nuevo proyecto).

 12. En el cuadro de diálogo New Project (Nuevo proyecto), introduzca el nombre, la ubicación, el título 

y la resolución del proyecto.

 13. Si el proyecto abierto no se ha guardado, confirme si desea guardarlo.

Se crea el nuevo proyecto con escenas y paneles creados automáticamente, y con los cuadros de 

texto rellenos con fragmentos del guion en función de la configuración que haya seleccionado.
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Capítulo 6: Adición y gestión de capas

Cada panel del storyboard puede estar compuesto por una o varias capas de dibujo. Esas capas se agrupan 

para realizar el dibujo en cada panel.

Tipos de capas

Storyboard Pro admite cuatro tipos de capas: capas de dibujo de vectores, capas de dibujo de mapa de bits, 

capas 3D y grupos.

 l Vector Layers (Capas de vectores): Los dibujos de vectores están formados por puntos y curvas que 

componen los contornos de las formas de la ilustración, junto con el color o las texturas de relleno. Por 

lo tanto, la ilustración en capas de vectores se puede escalar y ampliar sin que pierda calidad, a menos 

que contenga una textura.

Al dibujar en una capa de vector, cada trazo de dibujo y cada línea de lápiz es un objeto independiente 

que se puede manipular por separado. Puede seleccionar trazos y, a continuación, moverlos y 

transformarlos, incluso si se aplicaron trazos de dibujo sobre ellos. Además, debido a que los trazos de 

dibujo están formados por puntos y curvas, es posible editar su forma, lo que facilita las correcciones y 

los cambios en la ilustración.

 l Bitmap Layers (Capas de mapa de bits): Los dibujos de mapa de bits se componen de una cuadrícula de 

píxeles, que son puntos pequeños que tienen un solo color sólido. Las herramientas de dibujo de mapa 

de bits permiten colocar trazos de pincel en un único lienzo plano y ajustar la ilustración píxel a píxel si 

es necesario.
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Al dibujar en una capa de mapa de bits, cada trazo se compone en el l ienzo, por lo que continúa siendo 

un dibujo único que solo se puede pintar o borrar, pero que no permite ajustar partes individuales.

Las ilustraciones de mapa de bits solo se pueden escalar o ampliar tanto como lo permita su densidad 

de píxeles sin perder calidad de imagen. De forma predeterminada, la ilustración de mapa de bits tiene 

una densidad de píxeles del 100 %, que solo es suficiente para mostrar la ilustración sin ampliarla o 

escalarla; de lo contrario, Storyboard Pro debe generar nuevos píxeles en la ilustración, lo que puede 

hacer que se vea borrosa o pixelada.

Por lo tanto, es posible que desee establecer la densidad de píxeles requerida para la ilustración de 

mapa de bits, en función de si tendrá que ampliarla o escalarla, antes de comenzar a dibujar en una 

capa de mapa de bits.

 l 3D Layers (Capas 3D): Cuando importe un modelo 3D en la librería, si lo agrega a un panel, se 

almacenará el modelo en una capa 3D. A continuación, puede manipular y animar el modelo 3D al igual 

que con una capa de dibujo.

 l Group (Grupo): Un grupo puede contener varias capas de cualquier tipo. Al igual que puede transformar 

y animar una capa, también puede transformar y animar un grupo. Las transformaciones y animaciones 

aplicadas a un grupo afectarán a todas las capas del grupo simultáneamente.

La forma más fácil de seleccionar y gestionar capas en un panel es util izar el panel Layer (Capa), que se 

encuentra de forma predeterminada en la sección derecha de las vistas de escena y de cámara.

Sin embargo, también se puede agregar la vista de capas a la zona de trabajo, que funciona de la misma 

manera. A continuación, puede ocultar el panel Layer (Capa) haciendo clic en el botón Collapse (Contraer)  

situado en su esquina superior izquierda, y contar con más espacio para trabajar en las vistas de escena y de 

cámara.
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También puede gestionar capas util izando la vista de imágenes en miniatura. Si el tamaño de la vista de 

imágenes en miniatura es lo suficientemente grande, cada panel tendrá una lista vertical de capas en su borde 

derecho que le permitirá desplazarse por ellas y seleccionarlas. A la izquierda de la vista de imágenes en 

miniatura, debajo de la barra de herramientas de herramientas, se encuentra una barra de herramientas de 

capas, que le permite agregar capas al panel seleccionado o eliminarlas del mismo.

Adición de capas

De forma predeterminada, un panel contiene un fondo (BG) y una capa de dibujo (A), pero puede agregar 

tantas capas como necesite a cada panel del proyecto.

Adición de una capa a un panel

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione el panel al que desea agregar 

una nueva capa.

 2. En el panel Layer (Capa) de la vista de escena o de cámara, de la vista de capas o de la vista de 

imágenes en miniatura, seleccione la capa sobre la que desea crear una nueva capa.

 3. Realice una de las siguientes acciones:
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 l Haga clic en el botón Add Vector Layer (Agregar capa de vector)  o Add Bitmap 

Layer (Agregar capa de mapa de bits) . Estos botones se encuentran en la parte 

inferior del panel Layer (Capa) en las vistas de escena y de cámara, en la parte inferior 

de la vista de capas y en la barra de herramientas de capas.

 l En el menú superior, seleccione Layer > New > Vector Layer (Capa > Nueva > Capa 

de vector) o New Bitmap Layer (Nueva capa de mapa de bits).

Eliminación de capas

Puede eliminar capas que no necesite para evitar abarrotar la lista de capas.

Eliminación de una capa de un panel

 1. En el panel Layer (Capa) de la vista de escena o de cámara, de la vista de capas o de la vista de 

imágenes en miniatura, seleccione la capa que desea eliminar.

 2. Realice una de las siguientes acciones:

 l Haga clic en el botón Delete Selected Layers (Eliminar capas seleccionadas) . Este 

botón se encuentra en la parte inferior del panel Layer (Capa) en las vistas de escena 

y de cámara, en la parte inferior de la vista de capas y en la barra de herramientas de 

capas.

 l Haga clic con el botón derecho en la capa y seleccione Delete Layers (Eliminar 

capas).

 l En el menú superior, seleccione Layer > Delete Layers (Capa > Eliminar capas).

Agrupación de capas

Puede agrupar las capas para facilitar su gestión o si desea transformar y animar varias capas a la vez.

Agrupación de capas

 1. En el panel de capas de la vista de escena o de cámara o en la vista de capas, seleccione al menos 

dos capas que desee agrupar.

 2. Realice una de las siguientes acciones:

 l Haga clic en el botón Group Selected Layers (Agrupar capas seleccionadas) . Este botón 

se puede encontrar en la parte inferior del panel de capas en la vista de escena o de cámara, 

y en la parte inferior de la vista de capas.
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 l Haga clic con el botón derecho en la selección y, a continuación, seleccione Group Selected 

Layers (Agrupar capas seleccionadas).

 l En el menú superior, seleccione Layer > Group Selected Layers (Capa > Agrupar capas 

seleccionadas).

CONSEJO 

Puede arrastrar y colocar capas dentro o fuera de grupos.

Ocultar y visualizar capas

Al trabajar con muchas capas, puede ocultar temporalmente determinadas capas para evitar abarrotar la 

escena.

También puede ocultar un grupo. Al ocultar un grupo, todas las capas que contiene aparecen ocultas, pero se 

conserva su estado de visibilidad individual. Por lo tanto, si oculta solo algunas capas de un grupo, oculte el 

grupo y, a continuación, muéstrelo. Así, las capas que se ocultaron individualmente permanecerán ocultas, y 

las que estaban visibles se volverán a ver.
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Cómo mostrar u ocultar una capa

 1. Realice una de las siguientes acciones:

 l En el panel Layer (Capa) o en la vista de capas, haga clic en el icono Show/Hide Layer 

(Mostrar/ocultar capa)  justo a la izquierda de la capa.

 l En la vista de imágenes en miniatura, haga clic en el icono Show/Hide Layer (Mostrar/ocultar 

capa)  justo debajo del nombre de la capa.

 l En el panel Layer (Capa), la vista de capas o la vista de imágenes en miniatura, haga clic con 

el botón derecho en la capa y seleccione Show/Hide Layers (Mostrar/ocultar capas).

 l En el panel Layer (Capa), la vista de capas o la vista de imágenes en miniatura, seleccione la 

capa y, a continuación, seleccione Layer > Show/Hide Layers (Capa > Mostrar/ocultar capas) 

en el menú superior.

Bloqueo y desbloqueo de capas

Puede bloquear una capa seleccionada con el fin de proteger los objetos que contenga para impedir que se 

cambien. Una vez bloqueada, puede desbloquearla para realizar cambios en cualquier objeto de la misma.

Bloqueo o desbloqueo de una capa

 1. Realice una de las siguientes acciones:

 l En el panel Layer (Capa) o en la vista de capas, haga clic en el icono Lock/Unlock 

(Bloquear/desbloquear)  justo a la izquierda de la capa.

 l En la vista de imágenes en miniatura, haga clic en el icono Lock/Unlock 

(Bloquear/desbloquear)  justo debajo del nombre de la capa.

 l En el panel Layer (Capa), en la vista de capas o la vista de imágenes en miniatura, seleccione 

la capa. A continuación, realice una de las siguientes acciones:

 l A continuación, seleccione Layer > Lock/Unlock Layers (Capa > 

Bloquear/desbloquear capas) en el menú superior.
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 l En la barra de herramientas de capas, haga clic en el botón Lock/Unlock Layers 

(Bloquear/desbloquear capas) .

 l Pulse Alt + L.
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Capítulo 7: Cómo dibujar y pintar

Cómo dibujar

Al crear un nuevo proyecto en Storyboard Pro, puede comenzar a dibujar inmediatamente en el panel 

seleccionado util izando una de las herramientas de dibujo a su disposición.

Dibujo con la herramienta Brush (Pincel)

 1. En la vista de línea de tiempo o de imágenes en miniatura, seleccione el panel en el que desea 

dibujar.

 2. En el panel Layer (Capa) de la vista de escena, seleccione la capa sobre la que desea dibujar.

 3. Realice una de las siguientes acciones:

 l En la barra de herramientas de herramientas, seleccione la herramienta Brush (Pincel) .

 l En el menú superior, seleccione Tools > Brush (Herramientas > Pincel).

 l Pulse Alt + B.

 4. En la lista Presets (Valores predefinidos) de la vista de propiedades de la herramienta, seleccione 

un pincel predefinido que desee util izar.

 5. Util ice el control deslizante Maximum Size (Tamaño máximo) para seleccionar el tamaño deseado 

para el pincel.

 6. En la vista de color, realice una de las siguientes acciones para seleccionar un color:

 l Haga doble clic en la muestra de color actual para abrir la ventana Colour Picker (Selector de 

color).

 l Utilice los controles deslizantes Hue (Matiz), Saturation (Saturación) y Value (Valor) para 

seleccionar el color con el que desea dibujar.
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 l Seleccione una muestra de color de la lista de muestras.

 7. En la vista de escena, dibuje un trazo de pincel.

 8. Si desea realizar cambios en su pincel, en la vista de propiedades de la herramienta, haga clic en el 

botón de flecha para abrir el cuadro de diálogo Brush Properties (Propiedades del pincel). En este 

cuadro de diálogo, puede personalizar la forma, la textura y el comportamiento del pincel.

CONSEJOS 

 l Puede ajustar rápidamente el tamaño de la herramienta de dibujo seleccionada 

manteniendo pulsada la tecla y, a continuación, haciendo clic en la tecla O y, a 

continuación, arrastrando en el espacio de dibujo. Si util iza un lápiz de tableta, al hacerlo 

con la punta del borrador del lápiz ajustará el tamaño de la herramienta Eraser (Borrador), 

independientemente de la herramienta de dibujo seleccionada.

 l Si mantiene pulsada la tecla Mayús antes de dibujar o mientras lo hace, dibujará una línea 

recta.

 l Si mantiene pulsadas las teclas Mayús y Alt antes de dibujar o mientras lo hace, dibujará 

una línea recta horizontal o vertical.

 l Si mantiene pulsada la tecla Ctrl (W indows/Linux) o ⌘  (macOS) mientras dibuja, su trazo 

de dibujo se convertirá en una forma cerrada.

 l Si mantiene pulsada la tecla Alt antes de dibujar un trazo y comienza a dibujar cerca de un 

dibujo existente, el comienzo del trazo se conectará con el otro dibujo.

 l Si mantiene pulsada la tecla Alt mientras dibuja, y finaliza el trazo de dibujo cerca de otro 

dibujo existente, el final del trazo se conectará con dicho dibujo.
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Cómo pintar

También puede pintar los dibujos para obtener un aspecto más acabado. Puede pintar los personajes y props 

con sus esquemas de color, o simplemente rellenarlos de blanco para que sus contornos no se mezclen con el 

fondo.

Cómo pintar un dibujo

 1. Realice una de las siguientes acciones:

 l En la barra de herramientas de herramientas, seleccione la herramienta Paint (Pintar) .

 l En el menú superior, seleccione Tools > Paint (Herramientas > Pintar).

 l Pulse Alt + I.

 2. En la vista de color, realice una de las siguientes acciones para seleccionar un color:

 l Haga doble clic en la muestra de color actual para abrir la ventana Colour Picker (Selector de 

color).

 l Utilice los controles deslizantes Hue (Matiz), Saturation (Saturación) y Value (Valor) para 

seleccionar el color con el que desea dibujar.

 l Seleccione una muestra de color de la lista de muestras.

 3. En la vista de escena, empiece a pintar en el dibujo haciendo clic en el área que desea pintar. Si 

desea rellenar varias áreas al mismo tiempo, dibuje un lazo alrededor de ellas.
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NOTA 

Si la forma que está tratando de pintar no está completamente cerrada, no se rellenará. 

Puede hacer que la herramienta Paint (Pintar) cierre automáticamente pequeños 

huecos en las formas que intenta rellenar aumentando la configuración de Close Gap 

(Cerrar hueco)  de la herramienta Paint (Pintar) en la vista de propiedades de la 

herramienta. Para cerrar huecos grandes, puede util izar la herramienta Close Gap 

(Cerrar hueco) , disponible en el menú emergente de la herramienta Paint (Pintar) 
 en la barra de herramientas de herramientas.

Acerca de estilos artísticos, herramientas de dibujo y tipos de capas

Las dos herramientas de dibujo principales en Storyboard Pro son la herramienta  Brush (Pincel) y la 

herramienta  Pencil (Lápiz). Según el estilo de dibujo que desee lograr, es posible que prefiera trabajar con 

capas de vectores o de mapas de bits.

En las capas de vectores, es posible dibujar con líneas de lápiz, líneas de lápiz con textura, pinceles de vectores 

y pinceles de vectores con textura. Mientras que las líneas de lápiz son líneas centrales de vectores a las que 

puede agregar grosor, los trazos de pincel son formas de vector sólidas rellenas con un color y los trazos de 

pincel con textura son trazos de pincel rellenos de una textura de mapa de bits que filtra su color.
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En las capas de mapa de bits, solo puede dibujar util izando pinceles de mapa de bits sólidos o con textura. Por 

lo tanto, aunque las capas de vectores son más flexibles porque permiten manipular y ajustar fácilmente 

partes de la ilustración, también pueden albergar más estilos artísticos.

Sin embargo, si util iza un pincel con textura en una capa de vectores, los trazos de pincel tendrán una textura 

de mapa de bits. Esto significa que, al igual que con ilustraciones en capas de mapa de bits, intentar ajustar o 

cambiar el tamaño de un trazo de pincel con textura requerirá que Storyboard Pro vuelva a probar la textura, 

lo que puede hacer que pierda calidad de imagen, a menos que su resolución de textura se hubiera aumentado 

lo suficiente antes de comenzar a dibujar.

Una de las dificultades del uso de pinceles con textura en los dibujos de vectores es que, mientras que los 

dibujos de mapa de bits siempre están hechos de un solo lienzo plano, los trazos de pincel de vectores se 

guardan como objetos independientes. Esto significa que colocar muchos trazos de pincel con textura en un 

dibujo de vectores requerirá que Storyboard Pro almacene la textura para cada uno de estos trazos y los 

componga en tiempo real para mostrar el dibujo. Esto puede hacer que los dibujos de vectores cargados de 

textura, a diferencia de los dibujos de mapa de bits, hagan que el rendimiento de la aplicación sea más lento y 

el tamaño del archivo sea mayor. Sin embargo, este es el único caso en el que es probable que un dibujo de 

vectores sea más pesado que un dibujo de mapa de bits.

Aunque no se recomienda para el esbozo, las líneas de lápiz con textura son una buena solución. Las líneas de 

lápiz con textura son más ligeras y fáciles de editar. Esto significa que la textura se actualizará con la 

transformación si escala o ajusta la línea de lápiz. Esto también significa que se puede cambiar la textura 

aplicada a una línea de lápiz existente o aplicar una textura a una línea de lápiz que aún no la tenga. Las 

texturas de pincel se recomiendan sobre las líneas de lápiz con textura cuando se trata de conseguir 

pinceladas de aspecto natural.
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NOTA 

Incluso si aplana la ilustración, los trazos de pincel con textura de distintos colores no se pueden 

aplanar juntos en capas de vectores.

En la siguiente tabla se comparan los distintos enfoques de dibujo disponibles en Storyboard Pro:

Herramienta de 

dibujo

Tipo de 

capa
Especificaciones

Lápiz sólido Vector

Ventajas: muy ligero y fácil de ajustar. Se puede manipular, volver a 

colorear y ajustar mediante la línea central. Se puede acercar o aumentar 

de tamaño sin perder calidad.

Desventajas: no está optimizado para transparencia.

Uso recomendado: dibujos limpios con un estilo de contorno sólido y 

uniforme.

Lápiz con textura Vector

Ventajas: l igero y fácil de ajustar. Se puede manipular, volver a colorear y 

ajustar mediante la línea central. Se puede acercar o aumentar de tamaño 

sin perder calidad.

Desventajas: no está optimizado para transparencia. No se recomienda 

para realizar bocetos. No tiene un aspecto tan natural como los pinceles 

con textura.

Uso recomendado: para ilustraciones de textura ligera o de estilo mixto 

que requieren mucha manipulación de líneas.

Pincel de vectores 

sólido
Vector

Ventajas: tamaño de archivo ligero. Reproduce el estilo de animación 

tradicional. Se puede manipular, volver a colorear y editar mediante el 

contorno o la línea central. Se puede acercar o aumentar de tamaño sin 

perder calidad.

Desventajas: no puede reproducir el aspecto de los medios naturales.

Uso recomendado: bocetos, dibujos limpios de animación tradicional.

Pincel de vectores 

con textura
Vector

Ventajas: se puede reproducir el aspecto de los medios naturales. Cuenta 

con las mismas capacidades que los pinceles de mapa de bits con textura, 

pero se puede manipular, editar y volver a colorear como un pincel de 

vectores sólido.

Desventajas: los trazos superpuestos de pincel pueden provocar que el 

dibujo haga que el rendimiento de la aplicación sea lento y el tamaño de los 

archivos sea pesado. Los trazos de pincel de distintos colores no se pueden 

aplanar a la vez. Si se ajusta, aumenta de tamaño o acerca la ilustración, 

puede disminuir la calidad de la textura.
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Herramienta de 

dibujo

Tipo de 

capa
Especificaciones

Uso recomendado: para ilustraciones con textura de estilo de mapa de bits 

ligera o ilustraciones de estilo mixto.

Pincel de mapa de 

bits con textura

Mapa de 

bits

Ventajas: se puede reproducir el aspecto de los medios naturales. Mejor 

rendimiento y tamaño de archivo más ligero que las ilustraciones de 

vectores cargados de textura. Se puede editar píxel a píxel.

Desventajas: los trazos de pincel siempre se aplanan a la vez y no se 

pueden modificar por separado. Solo se pueden dibujar o borrar. Si se 

aumenta de tamaño o se acerca la ilustración, puede disminuir la calidad de 

la imagen.

Uso recomendado: ilustración de mapa de bits cargado de textura.
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Capítulo 8: Uso de guías de dibujo

Las guías de dibujo son ayudas para dibujar que puede agregar a su panel para ayudarle a dibujar fondos y 

objetos con líneas rectas, ángulos rectos y efectos de proyección gráfica, como la proyección isométrica, la 

perspectiva recta y la perspectiva curvilínea. En el arte tradicional, esto se hace con herramientas, como reglas, 

reglas T, escuadras y puntos de desaparición. Las guías permiten simular el uso de dichas herramientas junto 

con las herramientas de dibujo en Storyboard Pro.

Storyboard Pro admite distintos tipos de guías de dibujo, cada una diseñada para distintos tipos de tareas de 

dibujo. La mayoría de las guías de dibujo de Storyboard Pro funcionan agregando una línea de horizonte y 

puntos de desaparición a su espacio de dibujo. Cuando util iza una guía de dibujo, aparecen líneas de guía de 

puntos mediante el cursor del ratón. Estas líneas de guía son paralelas o perpendiculares a la línea de 

horizonte, o van desde uno de los puntos de desaparición de la guía hasta el cursor del ratón. Cuando empieza 

a dibujar un trazo, su herramienta de dibujo se fija inmediatamente a uno de los ejes de la guía, como si 

dibujara con una regla. También puede util izar las guías de dibujo como simples referencias visuales sin fijar la 

herramienta de dibujo a los ejes.

Storyboard Pro admite los siguientes tipos de guías de dibujo:

 l La regla le permite colocar y rotar un eje y, a continuación, dibujar una línea a lo largo de dicho eje, 

como una regla normal.

 l La cuadrícula cuadrada le ayuda a dibujar líneas paralelas o perpendiculares a la línea de horizonte.
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 l La guía de perspectiva isométrica le ayuda a dibujar líneas paralelas a uno de los tres ejes: el eje x, el 

eje y, y el eje z. El ángulo de cada eje se puede personalizar según sea necesario.

Este tipo de seudoperspectiva, también conocida como proyección paralela, a menudo se util iza en 

juegos 2D, infografías y esquemas para representar objetos y entornos 3D sin util izar ninguna 

perspectiva, escorzo o renderizado 3D real. En la animación 2D, a menudo se util iza para dibujar fondos 

de paneo largos desde un ángulo alto o bajo.

 

 l La guía de perspectiva con 1 punto le ayuda a dibujar líneas procedentes de un único punto de 

desaparición en el centro del horizonte. También le ayuda a dibujar líneas paralelas o perpendiculares a 

la línea de horizonte.

Esto es útil para dibujar estructuras de forma de cuboide que se encuentran de cara a la cámara.

 l La guía de perspectiva con 2 puntos le ayuda a dibujar líneas procedentes de uno de los dos puntos de 

desaparición, que se colocan en la línea de horizonte fuera del campo de la cámara. También le ayuda a 

dibujar líneas perpendiculares a la línea de horizonte.

Esto es útil para dibujar estructuras de forma de cuboide desde un ángulo horizontal específico.
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 l La guía de perspectiva con 3 puntos le ayuda a dibujar líneas procedentes de uno de los tres puntos de 

desaparición. Como con la guía de perspectiva con 2 puntos, se colocan dos puntos de desaparición en 

la línea de horizonte que se util izan para dibujar líneas horizontales en el eje x o en el eje z. El otro punto 

de desaparición se coloca debajo de la línea de horizonte para ayudarle a dibujar líneas en el eje y.

Esto es útil para dibujar estructuras de forma de cuboide desde un punto de vista elevado.

 l La guía de perspectiva con 3 puntos (plano nadir) le ayuda a dibujar líneas procedentes de uno de los 

tres puntos de desaparición. Como con la guía de perspectiva con 2 puntos, se colocan dos puntos de 

desaparición en la línea de horizonte que se util izan para dibujar líneas horizontales en el eje x o en el 

eje z. El otro punto de desaparición se coloca encima de la línea de horizonte para ayudarle a dibujar 

líneas en el eje y.

Esto es útil para dibujar estructuras de forma de cuboide desde un punto de vista bajo.
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 l La guía de perspectiva con 3 puntos (paneo horizontal) le ayuda a dibujar fondos panorámicos 

horizontales, con líneas horizontales curvilíneas. Un punto de desaparición se coloca en el centro de la 

línea de horizonte para ayudarle a dibujar líneas en el eje z y dos puntos de desaparición se colocan en 

la línea de horizonte fuera del campo de la cámara para definir la curva de las líneas horizontales. Las 

líneas verticales se colocan perpendicularmente a la línea de horizonte.

Esto es útil para dibujar fondos que se deben recorrer horizontalmente. El paneo horizontal de la 

cámara sobre el fondo dibujado con una guía de perspectiva con 3 puntos (paneo horizontal) simulará 

una rotación de la cámara en el eje y.

 l La guía de perspectiva con 3 puntos (paneo vertical) le ayuda a dibujar fondos panorámicos verticales, 

con líneas verticales curvilíneas. Un punto de desaparición se coloca en el centro de la línea de 

horizonte para ayudarle a dibujar líneas en el eje z y dos puntos de desaparición se colocan debajo de la 

línea de horizonte, fuera del campo de la cámara, para definir la curva de las líneas verticales. Las líneas 

horizontales se colocan en paralelo a la línea de horizonte.

Esto es útil para dibujar fondos que se deben recorrer verticalmente. El paneo vertical de la cámara 

sobre el fondo dibujado con una guía de perspectiva con 3 puntos (paneo vertical) simulará una rotación 

vertical de la cámara en el eje X.
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 l La guía de perspectiva continua con 4 puntos es muy parecida a la guía de perspectiva con 3 puntos 

(paneo horizontal), salvo que está diseñada para ayudarle a dibujar fondos panorámicos completos de 

360°.

Esta guía util iza 5 puntos de desaparición. Cuando dibuja una línea horizontal, se curva formando un 

arco sobre uno de los puntos de desaparición y llegando hasta los dos puntos de desaparición 

circundantes. Esto crea un efecto de perspectiva donde cada punto de desaparición representa uno de 

los puntos cardinales, salvo los puntos más a la izquierda y más a la derecha que representan el mismo 

punto cardinal, lo que crea un fondo en bucle. Los fondos creados con la guía de perspectiva continua 

con 4 puntos se pueden repetir en bucle horizontalmente para simular una rotación completa de la 

cámara en el eje y.

 l La guía de perspectiva continua con 4 puntos (paneo vertical) es muy parecida a la guía de 

perspectiva con 2 puntos, salvo que sus líneas verticales son curvilíneas, para que se pueda util izar para 

crear fondos de paneo verticales. Dos puntos de desaparición se encuentran en la línea de horizonte, 
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fuera del campo de la cámara, para ayudarle a dibujar líneas en el eje x y el eje z, y dos puntos de 

desaparición se colocan encima y debajo del campo de la cámara para definir la curva de las líneas 

verticales.

Esto es útil para dibujar fondos que se deben recorrer verticalmente, en los que objetos de forma de 

cuboide se ven desde un ángulo.

 l La guía de perspectiva con 5 puntos (ojo de pez) le ayuda a dibujar fondos curvilíneos en el eje x y en 

el eje y. Tiene un punto de desaparición central en la línea de horizonte desde el que se dibujan líneas 

en el eje z; dos puntos de desaparición en los extremos de su línea de horizonte para definir la curva de 

líneas horizontales; y dos puntos de desaparición encima y debajo de la línea de horizonte para definir la 

curva de las líneas verticales.

Esta guía se puede util izar para dibujar fondos con un efecto de objetivo gran angular con un estilo ojo 

de pez. También se puede util izar para dibujar fondos que se deben recorrer en varias direcciones.
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Para usar una guía de dibujo, en primer lugar debe agregarla a la lista de guías del panel actual. Para 

familiarizarse con las guías, puede comenzar agregando la guía de dibujo de perspectiva con 1 punto a la lista 

de guías.

Adición de una guía de dibujo de perspectiva con 1 punto al panel actual

 1. En la barra de herramientas de herramientas, seleccione la herramienta  Brush (Pincel),  

Pencil (Lápiz),  o  Line (Línea).

NOTA 

Las guías de dibujo solo están visibles en la vista de escena o de cámara cuando está 

seleccionada una de las herramientas.

 2. Agregue la vista de guías a su espacio de trabajo realizando una de las siguientes acciones:

 l En la esquina derecha de cualquier vista de su espacio de trabajo, haga clic en el botón  

Add View (Agregar vista) y seleccione Guides (Guías).

 l En el menú superior, seleccione W indows > Guides (Ventanas > Guías). 
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 3. En la vista de guías, haga clic en el botón  New Guide (Nueva guía) y seleccione  1-Point 

Perspective (Perspectiva con 1 punto).

La nueva guía aparece en la lista de guías.

Cuando se agrega una guía nueva, su línea de horizonte se configura en una posición y un ángulo predefinidos, 

y sus puntos de desaparición se configuran en una posición predefinida. En muchos casos, debe realizar 

ajustes en la guía para poder dibujar fondos y objetos desde el punto de vista correcto.

Ajuste de una guía de perspectiva con 1 punto en una 

 1. En la barra de herramientas de herramientas, seleccione la herramienta  Brush (Pincel),  

Pencil (Lápiz),  o  Line (Línea).

NOTA 

Las guías de dibujo solo están visibles en la vista de escena o de cámara cuando está 

seleccionada una de las herramientas.
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 2. En la vista de guías, asegúrese de que la opción  Enable Guides (Habilitar guías) esté activada.

 3. En la lista de guías, seleccione la guía de perspectiva con 1 punto en una en la que desee 

realizar ajustes.

La guía seleccionada aparece en la vista de escena o de cámara.

 4. Realice una de las siguientes acciones:

 l Para cambiar la guía de posición sin rotarla, haga clic y arrastre su punto de desaparición .

 l Para rotar la guía, haga clic y arrastre su línea de horizonte.

CONSEJOS 

 l Cuando el ratón se coloca encima de la línea de horizonte, el cursor del ratón 

cambiará a  para indicar que está a punto de rotar la guía.

 l Al rotar una guía, su ángulo se muestra en la esquina superior izquierda de la 

vista de escena o de cámara.

 5. Una vez que haya terminado de realizar ajustes en la guía, puede hacer clic en el botón  Lock 

Guides (Bloquear guías) en la vista de guías para evitar modificar su guía accidentalmente mientras 

dibuja.

Una vez que la guía esté seleccionada y correctamente colocada, puede comenzar a dibujar con ella.

Dibujo con guías de dibujo

 1. En la barra de herramientas de herramientas, seleccione la herramienta  Brush (Pincel),  

Pencil (Lápiz),  o  Line (Línea).
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NOTA 

Las guías de dibujo solo están visibles en la vista de escena o de cámara cuando está 

seleccionada una de las herramientas.

 2. En la vista de guías, seleccione la guía que desee usar.

 3. Para evitar editar su guía accidentalmente mientras dibuja, haga clic en el botón  Lock Guides 

(Bloquear guías) en la vista de guías para activarla.

 4. Si desea bloquear sus trazos con los ejes de la guía, asegúrese de que la opción  Align 

w ith Guide (Alinear con guía) de la vista de guías esté activa. En caso contrario, desactívela para 

poder dibujar libremente y use solo las guías como referencias.

 5. Mueva el cursor del ratón por el espacio de dibujo. Observe que las líneas de guías pasan por el 

cursor del ratón, una por cada uno de los ejes de la guía de dibujo.

 6. Comience a dibujar en trazo en el mismo ángulo que uno de los ejes.

Si la opción  Align w ith Guide (Alinear con guía) está habilitada, el trazo se alinea con el eje más 

cercano a su ángulo, como si dibujara con una regla.
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CONSEJOS 

 l También puede seleccionar manualmente el eje al que desee fijar el trazo pulsando las 

teclas flecha izquierda y de flecha derecha para pasar por cada eje. El eje seleccionado 

aparecerá más resaltado que los demás. Si pasa por todos los ejes, ningún eje estará 

resaltado, lo que significa que el eje al que se fija la herramienta de dibujo se vuelve a 

determinar en función del ángulo de su trazo.

 l Esté dibujando o no, puede fijar la posición y el ángulo de las líneas de guía manteniendo 

pulsada la tecla Alt. Las líneas de guía dejarán de seguir el cursor del ratón, lo que le 

permitirá mantenerlas en un ángulo y posición específicos. Esto se puede util izar para 

dibujar sobre la misma línea varias veces para ajustar su longitud y grosor.

Una vez que haya terminado de trabajar con las guías, puede deshabilitarlas. Cuando las guías de dibujo están 

deshabilitadas, no se muestran en el espacio de dibujo y no afectan al comportamiento de las herramientas de 

dibujo.

Habilitación y deshabilitación de guías de dibujo

 1. Para habilitar o deshabilitar las guías de dibujo, realice una de las siguientes acciones:

 l En la vista de guías, haga clic en el botón Enable Guide (Habilitar guía) .

 l Pulse G.

NOTAS 

 l Las guías se habilitan automáticamente al agregar una nueva guía o al seleccionar una 

guía en la lista de guías.

 l La guía que seleccionó en su panel al deshabilitar las guías se volverá a seleccionar cuando 

vuelva a habilitar las guías.

 l Las guías de dibujo solo funcionan con las herramientas Herramientas  Brush (Pincel), 
 Pencil (Lápiz) y  Line (Línea). Si se selecciona cualquier otra herramienta, las guías 

de dibujo se comportarán como si estuvieran deshabilitadas.
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Capítulo 9: Importación de imágenes

Si tiene imágenes listas para su storyboard, puede importarlas en el proyecto de Storyboard Pro. Las 

imágenes se pueden importar como nuevas escenas en su proyecto o como nuevas capas en un panel. Puede 

importar una o varias imágenes al mismo tiempo.

NOTA 

También puede importar imágenes como clips de vídeo; consulte Importación de vídeos.

Importación de imágenes como escenas

 1. Seleccione File > Import > Images as Scenes (Archivo > Importar > Imágenes como escenas).

Se abre el buscador Choose Image Files (Seleccionar archivos de imagen).

 2. Busque las imágenes que desee, seleccione una o más imágenes y haga clic en Open (Abrir).

Se crea una nueva escena al final del proyecto para cada una de las imágenes importadas.

Importación de imágenes como capas en un panel mediante el cuadro de diálogo 
Import Images (Importar imágenes)

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione el panel en el que desea 

importar imágenes.

 2. En el menú superior, seleccione File > Import > Images as Layers (Archivo > Importar > Imágenes 

como capas).

Se abre el cuadro de diálogo Choose Image Files (Seleccionar archivos de imagen).

 3. Busque el directorio que contenga las imágenes que desea importar.

 4. Seleccione las imágenes que desea importar.
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CONSEJO 

Puede seleccionar varios archivos mediante una de las siguientes acciones:

 l Mientras pulsa Ctrl (W indows/Linux) o ⌘  (macOS), haga clic en cada uno de los 

archivos que desee seleccionar.

 l Mientras pulsa Mayús, haga clic en el primer archivo que desee seleccionar y, a 

continuación, en el último archivo que desee seleccionar para seleccionar todos los 

archivos intermedios.

 5. Haga clic en Open (Abrir).

 6. Si se selecciona un archivo Photoshop Document (.psd) con varias capas, aparecerá un mensaje 

que ofrecerá la opción de importar cada capa por separado.

 l Haga clic en Yes (Sí) para importar cada capa del documento como su propia capa en el 

panel.

 l Haga clic en No para importar todo el documento como una sola capa en el panel.

Se crea en el panel una capa que contiene la imagen importada. Si ha seleccionado más de una 

imagen, cada imagen se importará en su propia capa en orden alfanumérico.

Importación de imágenes como capas en un panel con arrastrar y colocar

 1. Abra la ventana del Explorador (W indows) o el Finder (macOS).

 2. Busque la ubicación de los elementos de imágenes que desee exportar.
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 3. Seleccione todos los elementos de imágenes que desee importar.

CONSEJO 

Puede seleccionar varios archivos mediante una de las siguientes acciones:

 l Mientras pulsa Ctrl (W indows/Linux) o ⌘  (macOS), haga clic en cada uno de los 

archivos que desee seleccionar.

 l Mientras pulsa Mayús, haga clic en el primer archivo que desee seleccionar y, a 

continuación, en el último archivo que desee seleccionar para seleccionar todos los 

archivos intermedios.

 4. Asegúrese de que tanto la ventana de Storyboard Pro como la ventana del Explorador o el Finder 

estén visibles.

 5. En la vista de imágenes en miniatura o de línea de tiempo, realice al menos una de las siguientes 

acciones:

 l Seleccione el panel en el que desee importar imágenes.

 l Desplácese al panel en el que desee importar imágenes.

 6. En la ventana del Explorador o del Finder, haga clic y arrastre uno de los archivos seleccionados:

 l Para importar las imágenes en el panel actual, coloque los archivos seleccionados en la vista 

de escena, la vista de cámara o la vista de capas.

 l Para importar las imágenes en cualquier otro panel, coloque los archivos seleccionados 

sobre el panel de destino en la vista de imágenes en miniatura o de línea de tiempo. 
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NOTA 

La imagen miniatura del panel de objetivos puede tardar unos segundos en 

actualizarse.

La imagen se importará en una capa del panel de destino, encima de todas las demás capas de ese 

panel. 
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Capítulo 10: Creación de una animática

Una vez creado el storyboard, el siguiente paso es convertirlo en una animática. Una animática es un vídeo que 

reproduce cada panel del storyboard. Cada panel se debe sincronizar para que coincida con el tiempo previsto 

de las acciones, y cada escena se debe sincronizar para que coincida con el ritmo previsto de la historia. Los 

movimientos de la cámara se pueden animar para simular cómo se verá la acción en relación con los 

movimientos y el fotograma de cámara. Las capas del storyboard también se pueden animar para que la 

acción y su tiempo se puedan leer con más facilidad.

Se pueden agregar efectos de sonido, clips de voz y pistas de música, ya sean provisionales o finales, para 

marcar el ritmo de la acción que las rodea, así como para crear un borrador de la mezcla de sonido para el 

producto final. También se pueden agregar a la animática vídeos e imágenes fijas, como secuencias de 

apertura o finalización, superposiciones, cuadros de texto, logotipos o material de acción en vivo para 

util izarlos como referencias o para que no se tengan que crear bocetos en paneles.

En Storyboard Pro, puede crear una animática a partir del storyboard util izando la vista de línea de tiempo. La 

vista de línea de tiempo se parece mucho a la línea de tiempo de un software de edición de vídeo. Entre otras 

cosas, permite ajustar visualmente el tiempo de cada panel, importar, preparar y recortar los clips de sonido y 

de vídeo, animar los movimientos de la cámara, animar capas y agregar transiciones entre escenas. Por lo 

tanto, le acompañará en cada paso hacia la creación de la animática.

Acceso a la vista de línea de tiempo

 1. Realice una de las siguientes acciones:

 l En la esquina superior derecha de la vista de imágenes en miniatura, haga clic en el botón 
 Add View (Agregar vista) y seleccione Timeline (Línea de tiempo).
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 l Seleccione W indows > Timeline (Ventanas > Línea de tiempo).

La primera vez que abra la vista de línea de tiempo después de crear un storyboard, observará que todos los 

paneles del storyboard ya se encuentran en la pista y sincronizados para que duren un segundo cada uno. Por 

lo tanto, el storyboard ya es una animática sencilla. El siguiente paso desde ese punto es ajustar la longitud de 

cada panel para que coincida con el tiempo previsto de las acciones y el ritmo previsto de las escenas.

Antes, durante y después de ajustar el tiempo de los paneles, puede ver cómo se desarrolla la animática y 

cómo se percibe con su tiempo actual al previsualizarlo.

Vista previa de la animática

 1. En la vista de línea de tiempo o de imágenes en miniatura, seleccione el panel que desea reproducir 

para comenzar.

 2. En la barra de herramientas de reproducción, haga clic en el botón  Play (Reproducir).

Al final, una animática se puede exportar a archivos de vídeo o incluso a escenas de Toon Boom Harmony; 

consulte Exportación del proyecto en la página 119.

Configuración de la duración del panel

La duración de un panel se puede establecer de varias formas. La vista de panel permite escribir la duración 

exacta del panel actual. La vista de línea de tiempo permite ampliar o reducir paneles visualmente. La duración 

de un panel también puede ajustar mediante los atajos de teclado Add Frame to Panel (Agregar fotograma a 

panel) y Remove Frame to Panel (Eliminar fotograma de panel).

De forma predeterminada, cuando ajusta la duración de un panel, este se desplaza o se propaga a todos los 

paneles posteriores. De este modo, todos los paneles y escenas se mantienen unidos en una sola secuencia 

continua y puede ajustar el tiempo de cada panel por separado.

Definición de la duración de un panel por fotograma

 1. En la vista de línea de tiempo o de imágenes en miniatura, seleccione un panel.

 2. Realice una de las siguientes acciones:
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 l En la vista de panel, escriba la longitud exacta del panel en el campo Duration (Duración).

NOTA 

El formato de la duración es H:MM:SS:FF, donde H significa horas, M significa 

minutos, S significa segundos y F significa fotogramas. 

 l En la vista de panel, a la derecha del campo Duration (Duración), haga clic en la flecha arriba 
 para ampliar el panel un fotograma o en la flecha abajo  para reducir el panel un 

fotograma.

 l Pulse + para agregar un fotograma al panel o - para eliminar un fotograma del panel.

 l En el menú superior, seleccione Storyboard > Add Frame to Panel (Storyboard > Agregar 

fotograma a panel) o Storyboard > Remove Frame from Panel (Storyboard > Eliminar 

fotograma de panel).

Ajuste de la longitud de un panel en la vista de línea de tiempo y ondulación de 
paneles posteriores

 1. Coloque el cursor cerca del borde derecho del panel cuyo tamaño desea cambiar.

Se muestra el icono de cambio de tamaño . Asegúrese de que apunta hacia el interior del panel 

cuyo tamaño desea cambiar.
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 2. Haga clic y arrastre el borde hacia la derecha para ampliarlo o hacia la izquierda para reducirlo.

A medida que lo arrastra, se indica la nueva longitud del panel y la cantidad de tiempo que suma o 

resta al mismo.

Todos los paneles posteriores se ondularán hacia delante o hacia atrás para conservar su longitud.

CONSEJO 

También puede ampliar o reducir un panel haciendo clic y arrastrando su borde izquierdo.

Cuando lo haga, si arrastra hacia la izquierda lo ampliará, y si arrastra hacia la derecha lo 

reducirá.

También es posible ajustar la longitud de un panel mientras se ajusta simultáneamente la longitud del 

siguiente panel para compensarlo. Así se evita que los paneles posteriores se desplacen y puede ser útil si 

necesita ajustar el tiempo de los paneles sin que afecte al tiempo del resto de la animática.
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Desplazamiento de la transición entre dos paneles sin desplazar los paneles 
posteriores

 1. Mientras mantiene pulsada la tecla Alt, coloque el cursor sobre el borde derecho del panel cuyo 

tamaño desea cambiar.

Se muestra el icono de cambio de tamaño .

 2. Mientras mantiene pulsada la tecla Alt, haga clic y arrastre el borde del panel hacia la derecha para 

ampliarlo o hacia la izquierda para reducirlo.

A medida que lo arrastra, se indica la nueva longitud del panel y la cantidad de tiempo que suma o 

resta al mismo.

La longitud del siguiente panel se ajustará para evitar el desplazamiento de paneles posteriores.

Modo de edición de animática

De forma predeterminada, los cambios que realice en la longitud de las escenas y los paneles provocarán que 

las escenas y los paneles posteriores se propaguen hacia delante y hacia atrás para asegurarse de que no 

haya ningún hueco en la línea de tiempo.

Cuando Animatic Editing Mode (Modo de edición de animática) esté habilitado, es posible cambiar la posición 

del punto de entrada y de salida de cada panel sin que ello afecte a ningún otro elemento de la animática. Esto 

significa que, en este modo, al acortar o eliminar un panel se crea un hueco en la línea de tiempo en el que se 

puede ampliar, mover o crear otro panel. También puede borrar paneles o escenas, y dejar atrás los orificios en 

lugar de propagar los paneles siguientes hacia atrás.

A continuación, en los huecos que creó en la animática, puede mover los paneles existentes, crear nuevos 

paneles o cambiar el tamaño de un panel junto al hueco para llenarlo.
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De esta manera, el modo de edición de animática hace que el flujo de trabajo en Storyboard Pro sea más 

parecido al de un software típico de edición de vídeo, lo cual puede facilitar la edición a los usuarios que estén 

familiarizados con este tipo de aplicaciones.

Cambio al modo de edición de animática

 1. En la esquina inferior izquierda de la vista de línea de tiempo, haga clic en el botón Animatic Editing 

Mode (Modo de edición de animática) .

 2. Una vez que haya terminado de usar el modo de edición de animática, solo tiene que hacer clic de 

nuevo en el botón para deshabilitarlo.

CONSEJOS 

 l Cuando el modo de edición de animática esté desactivado, puede mantener pulsada la 

tecla Ctrl (W indows) o ⌘  (macOS) para habilitar temporalmente el modo de edición de 

animática mientras realiza cambios en la animática. Del mismo modo, cuando el modo de 

edición de animática esté habilitado, se deshabilitará temporalmente al mantener pulsada 

la tecla Ctrl (W indows) o ⌘  (macOS).

 l También puede asignar un atajo de teclado al comando Toggle Animatic Editing Mode 

(Alternar modo de edición de animática) en la sección Storyboard del cuadro de diálogo 

Keyboard Shortcuts (Atajos de teclado), que lo alterna pulsando la tecla, sin necesidad de 

mantenerla pulsada.
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Ajuste del punto de entrada de un panel en modo de edición de animática

 1. Coloque el cursor cerca del borde izquierdo del panel.

Se muestra el icono de cambio de tamaño . Asegúrese de que apunta hacia el interior del panel 

que desea editar.

 2. Haga clic y arrastre el borde hacia la derecha para mover el punto de entrada hacia delante, o hacia 

la izquierda para moverlo hacia atrás.

A medida que lo arrastra, se indica la nueva longitud del panel y la cantidad de tiempo que suma o 

resta al mismo.

NOTA 

No puede mover el punto de entrada de un panel o escena antes del punto de salida del panel 

o escena anterior.
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Ajuste del punto de salida de un panel en modo de edición de animática

 1. Coloque el cursor cerca del borde derecho del panel.

Se muestra el icono de cambio de tamaño . Asegúrese de que apunta hacia el interior del panel 

que desea editar.

 2. Haga clic y arrastre el borde hacia la izquierda para mover el punto de salida hacia atrás, o hacia la 

derecha para moverlo hacia delante.

A medida que lo arrastra, se indica la nueva longitud del panel y la cantidad de tiempo que suma o 

resta al mismo.

NOTA 

No puede mover el punto de salida de un panel o escena más allá del punto de entrada del 

siguiente panel o escena.
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Cómo eliminar paneles y dejar un hueco en la línea de tiempo en el modo de edición 
de animática

 1. Seleccione los paneles que desee eliminar.

CONSEJOS 

 l Puede seleccionar varios paneles manteniendo pulsada la tecla Ctrl (W indows) o ⌘  

(macOS) y haciendo clic en cada panel que desee eliminar.

 l Puede seleccionar una secuencia de varios paneles haciendo clic en el primer panel 

que desee seleccionar y, mientras mantiene pulsada la tecla Mayús, haciendo clic en 

el último panel que desee seleccionar. Todos los paneles intermedios se 

seleccionarán.

 2. Realice una de las siguientes acciones:

 l Haga clic con el botón derecho en la selección y seleccione Clear Panels (Borrar paneles).

 l En el menú superior, seleccione Edit > Clear Panels (Editar > Borrar paneles).

 l Pulse Supr (W indows) o ⌫ (macOS).

Los paneles seleccionados se eliminarán y quedará un espacio en su lugar.

En el modo de edición de animática, los paneles no se propagan hacia delante o hacia atrás, lo cual puede ser 

limitante. Para sacar el máximo provecho del modo de edición de animática, es útil saber cómo propagar los 

paneles sobre la marcha.

En cualquier momento, puede mantener pulsada la tecla Ctrl (W indows) o ⌘  (macOS) antes de editar la 

animática para habilitar o deshabilitar temporalmente el modo de edición de animática. Esto significa que, 

cuando el modo de edición de animática está habilitado, si mantiene pulsada la tecla Ctrl (W indows) o ⌘  

(macOS), lo desactivará temporalmente y cualquier cambio que realice en la animática mientras mantenga 
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pulsada esta tecla desplazará todos los paneles después del panel afectado. Si hay huecos en la línea de 

tiempo, también se propagan hacia delante o hacia atrás.

Si necesita crear un hueco o ajustar el tamaño de un hueco, puede hacerlo seleccionando todos los paneles 

desde un punto específico hasta el final de la animática y, a continuación, moviendo la selección.

Selección y propagación de todos los paneles desde un punto específico de la 
animática en el modo de edición de animática

 1. Mantenga pulsadas las teclas Ctrl (W indows) o ⌘  (macOS), Alt y Mayús.

 2. Mientras mantiene pulsadas dichas teclas, en la vista de línea de tiempo, haga clic en el primer 

panel de la secuencia de paneles que desee desplazar.

Se seleccionará el panel en el que hizo clic y todos los paneles posteriores hasta el final de la 

animática.

 3. Haga clic y arrastre la selección para desplazarla.

Adición de transiciones

Las transiciones son efectos animados que se pueden agregar entre dos escenas para pasar de una escena a la 

siguiente gradualmente, como un fundido o un barrido de bordes. Entre otras cosas, la adición de transiciones 

puede ayudar a ajustar el ritmo entre las escenas o a marcar cambios en la configuración de la historia.
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Adición de una transición

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione la primera de las dos escenas 

entre las que desee agregar una transición. Por ejemplo, si desea agregar una transición entre las 

escenas 2 y 3, seleccione cualquier panel de la escena 2.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas Storyboard, haga clic en el botón New Transition (Nueva 

transición) .

 l Seleccione Storyboard > Add Transition (Storyboard > Agregar transición).

 l Haga clic con el botón derecho en las imágenes en miniatura de la escena y seleccione Add 

Transition (Agregar transición).

 3. Haga clic en la transición para seleccionarla.

 4. Abra la vista de panel. Al seleccionar una transición, la vista de panel muestra sus propiedades y 

permite cambiarlas.

 5. En la lista desplegable Type (Tipo), seleccione qué tipo de transición desea util izar:

 l Dissolve (Fundido): Hace que la primera escena se desvanezca a negro y que la segunda 

aparezca gradualmente del negro.

 l Edge W ipe (Barrido de bordes): Barre la primera escena con la segunda con una línea recta 

que atraviesa la pantalla. El ángulo de la línea se puede personalizar.
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 l Clock W ipe (Barrido en reloj): Barre la primera escena con la segunda con una línea que va 

del centro de la pantalla a su borde y que gira 360 grados para cubrir toda la pantalla. El 

ángulo y la dirección iniciales de la línea se pueden personalizar.

 l Slide (Deslizar): Cuando se establece en Slide In (Deslizar acercando), la segunda escena se 

desliza desde el borde de la pantalla sobre la primera escena. Cuando se establece en Slide 

Out (Deslizar alejando), la primera escena se desliza hacia el borde de la pantalla, dejando la 

segunda escena en la pantalla como si siempre hubiera estado detrás de ella. El ángulo al 

que la escena se desliza acercando o alejando se puede personalizar.

 6. Determine la duración de la transición realizando una de las siguientes acciones:

 l En la vista de línea de tiempo, haga clic y arrastre el borde derecho de la transición hacia la 

derecha para ampliarlo o hacia la izquierda para reducirlo.

 l En la vista de panel, a la derecha del campo de duración, haga clic en la flecha arriba  para 

ampliar la transición un fotograma o en la flecha abajo  para reducir la transición un 

fotograma.

 l En el campo de duración de la vista de panel, escriba la duración de la transición.

NOTA 

El formato de la duración es H:MM:SS:FF, donde H significa horas, M significa 

minutos, S significa segundos y F significa fotogramas.

NOTA 

Al ampliar una transición, se propagará hacia atrás en las escenas resultantes, y al 

reducirla, se propagará hacia delante en las escenas resultantes. Esto se debe a que las 

escenas previas y posteriores a la transición se superponen durante la transición. Por 

tanto, la escena posterior a la transición comienza, mientras que la escena anterior a la 

transición aún no ha finalizado, lo que reduce la duración del proyecto.
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Para crear movimiento de la cámara en una escena, debe comenzar creando al menos dos fotogramas clave de 

cámara y, a continuación, establecer la posición de la cámara en cada uno de esos fotogramas clave. 

Storyboard Pro interpolará la posición de la cámara en cada fotograma entre dos fotogramas clave.

Animación de la cámara en una escena

 1. Seleccione la herramienta Camera (Cámara) realizando una de las siguientes acciones:

 l En la barra de herramientas de herramientas, seleccione la herramienta Camera (Cámara) 
.

 l En el menú superior, seleccione Tools > Camera (Herramientas > Cámara).

 2. En la vista de línea de tiempo, haga clic y arrastre el cursor de la línea de tiempo hasta el fotograma 

en el que desea que comience el movimiento de la cámara.

 3. Cree un fotograma clave de cámara realizando una de las siguientes acciones:

 l En la vista de línea de tiempo, en la columna izquierda de la pista de cámara, haga clic en el 

botón Add Keyframe (Agregar fotograma clave) .

 l En el menú superior, seleccione Camera > Add Camera Keyframe at Current Frame 

(Cámara > Agregar fotograma clave de cámara al fotograma actual).

 l En la vista de propiedades de la herramienta, haga clic en el botón Add Keyframe (Agregar 

fotograma clave)  del panel Camera Transform (Transformación de cámara).

Se agrega un fotograma clave en la pista de cámara de la vista de línea de tiempo donde se 

encuentre el cursor de la línea de tiempo.

 4. En la vista de línea de tiempo, haga clic y arrastre el cursor de la línea de tiempo hasta el fotograma 

en el que desea que finalice el movimiento de la cámara.

 5. Cree un fotograma clave de cámara realizando una de las siguientes acciones:

 l En la vista de línea de tiempo, en la columna izquierda de la pista de cámara, haga clic en el 

botón Add Keyframe (Agregar fotograma clave) .

 l En el menú superior, seleccione Camera > Add Camera Keyframe at Current Frame 

(Cámara > Agregar fotograma clave de cámara al fotograma actual).
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 l En la vista de propiedades de la herramienta, haga clic en el botón Add Keyframe (Agregar 

fotograma clave)  del panel Camera Transform (Transformación de cámara).

Se agrega otro fotograma clave en la pista de cámara de la vista de línea de tiempo donde se 

encuentre el cursor de la línea de tiempo.

 6. Realice una de las siguientes acciones:

 l En la pista de cámara de la vista de línea de tiempo, seleccione el fotograma clave de la 

cámara que desea modificar. 

 l En la vista de escena o de cámara, aleje la vista para ver todos los fotogramas de la cámara. 

A continuación, seleccione el fotograma de la cámara que desea modificar haciendo clic en 

su borde o su punto central.
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CONSEJO 

Incluso si los fotogramas de la cámara se encuentran en la misma posición, puede 

seleccionar uno específico en la vista de escena o de cámara. Justo debajo de la esquina 

inferior izquierda de los fotogramas de la cámara encontrará puntos azules con forma 

cuadrada. Se puede hacer clic en cada uno de estos puntos para seleccionar un 

fotograma de cámara específico. Si dos o más fotogramas clave de la cámara se 

encuentran en la misma posición, el orden de estos puntos representará su posición 

relativa en la línea de tiempo. El punto situado más a la izquierda se puede util izar para 

seleccionar el primer fotograma clave de la cámara, el segundo punto situado más a la 

izquierda se puede util izar para seleccionar el segundo fotograma clave de la cámara, 

etc.

 7. Util ice uno de los siguientes métodos para modificar el fotograma de la cámara:

 l Mover: Mueva el cursor del ratón sobre el borde o el punto central del fotograma de la 

cámara hasta que el cursor se convierta en  y, a continuación, haga clic y arrastre el 

fotograma de la cámara para moverlo.
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 l Aproximar o retirar: Mueva el cursor del ratón sobre el punto situado en la esquina superior 

izquierda del fotograma de la cámara hasta que el cursor se convierta en  y, a 

continuación, haga clic y arrastre esta esquina para contraer o estirar el fotograma de la 

cámara. Al contraer el fotograma de la cámara, lo acercará, y al estirarlo, lo alejará.

 l Rotar: Mueva el cursor del ratón fuera de una de las esquinas del fotograma de la cámara 

hasta que el cursor se convierta en  y, a continuación, haga clic y arrastre la esquina en 

cualquier dirección para rotar el fotograma de la cámara a la derecha o a la izquierda.

CONSEJO 

También puede realizar un desplazamiento pequeño del fotograma de la cámara 

util izando las teclas de flecha del teclado o introducir sus coordenadas exactas en la 

vista de propiedades de la herramienta.

 8. Repita estos pasos para los demás fotogramas clave de la cámara, si es necesario.

 9. Desplace el cursor de la línea de tiempo al principio de la escena.

 10. En la barra de herramientas de reproducción, haga clic en el botón Play (Reproducir)  para 

obtener una vista previa del movimiento de la cámara.
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Capítulo 12: Animación de capas

De forma predeterminada, las capas de Storyboard Pro son estáticas, pero se pueden animar.

Una capa se anima mediante su configuración en distintas posiciones, ángulos o tamaños en dos fotogramas 

diferentes en la línea de tiempo y, a continuación, permitiendo que Storyboard Pro calcule la posición, el 

ángulo y el tamaño de la capa de cada fotograma entre esos dos fotogramas. Los fotogramas al principio y al 

final de una animación se conocen como fotogramas clave.

Puede animar una capa habilitando la animación en ella, acción que creará un fotograma clave en su posición 

actual en el fotograma actual. A partir de ahí, puede ir a otro fotograma y cambiar su posición, acción que 

creará automáticamente otro fotograma clave en el fotograma actual. En este punto, la capa ya está animada 

desde su posición original hasta la posición a la que la acaba de mover.

Animación de una capa

 1. En la vista de línea de tiempo, seleccione el panel con la capa que desea animar.

 2. Mueva el cursor de la línea de tiempo al momento exacto en el que desea crear el primer fotograma 

clave de la animación.

 3. En el panel Layer (Capa) de la vista de escena o de cámara, haga clic en el botón Animate (Animar) 
 del objeto 3D que desea animar.

El botón Animate (Animar)  cambia a color amarillo y también cambia de forma.

En la pista de animación de capa de la vista de línea de tiempo se crea un fotograma clave en el 

fotograma actual. Este fotograma clave almacena la posición, el ángulo y el tamaño de la capa en 

el fotograma actual.
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 4. En la barra de herramientas de herramientas, seleccione la herramienta Layer Transform 

(Transformación de capas) .

En la vista de escena o de cámara, los controles de la herramienta Layer Transform 

(Transformación de capas) aparecen alrededor de la capa de dibujo seleccionada.

 5. Mediante el cuadro del manipulador, transforme la capa para que tenga la posición, el ángulo y el 

tamaño que desee al comienzo de la animación:

 l Para mover la capa, haga clic en su ilustración o en el punto azul en el centro y, a 

continuación, arrástrela a la posición deseada.
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CONSEJOS 

 l Si tiene problemas para arrastrar la capa por su ilustración, también puede 

hacer clic y arrastrar el punto azul  del centro. Sin embargo, este punto 

puede estar obstruido por el punto de pivote  de la capa. Si es el caso, 

puede hacer clic y arrastrar el punto de pivote para apartarlo del camino y, a 

continuación, hacer clic y arrastrar el punto central para mover la capa.

 l También puede desplazar un poco la selección mediante las teclas de flecha 

del teclado.

 l También puede escribir coordenadas específicas en los campos Horizontal 

Offset (Desplazamiento horizontal)  y Vertical Offset (Desplazamiento 

vertical)  de la vista de propiedades de la herramienta.

 l Para escalar la capa, haga clic en uno de los cuadrados de los bordes o esquinas del cuadro 

del manipulador y arrástrelo para estirar o contraer el dibujo.

CONSEJOS 

 l Puede conservar las proporciones horizontal y vertical de la selección si 

mantiene pulsada la tecla Mayús.

 l También puede escribir porcentajes de escala específicos en los campos 

Horizontal Scale (Escala horizontal)  y Vertical Scale (Escala vertical)  

de la vista de propiedades de la herramienta.

 l Para rotar la capa, mueva el cursor fuera de una de las esquinas del cuadro del manipulador 

hasta que el cursor del ratón se convierta en . A continuación, haga clic y arrastre en 

cualquier dirección para rotar la capa a la derecha o a la izquierda.
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CONSEJOS 

 l Puede rotar la ilustración en incrementos de 15° si mantiene pulsada la tecla 

Mayús.

 l También puede introducir un ángulo específico en grados en el campo Angle 

(Ángulo)  de la vista de propiedades de la herramienta.

 l También puede rotar el clip en incrementos de 90° haciendo clic en el botón 

Rotate 90 CW  (Rotar 90 derecha)  en la vista de propiedades de la 

herramienta para rotarlo 90° a la derecha, o en el botón Rotate 90 CCW  

(Rotar 90 izquierda)  para rotarlo 90° a la izquierda.

 l Para voltear la capa en horizontal, haga clic en el botón Flip Horizontally (Voltear en 

horizontal)  de la vista de propiedades de la herramienta.

 l Para voltear la capa en vertical, haga clic en el botón Flip Vertically (Voltear en vertical)  

de la vista de propiedades de la herramienta.

 l Para restablecer una capa a su posición, escala y ángulo originales, realice una de las 

siguientes acciones:

 l Seleccione Layer > Reset Transform (Capa > Restablecer transformación).

 l Pulse Ctrl + R (W indows) o ⌘  + R (macOS).

 6. En la vista de línea de tiempo, mueva el cursor al fotograma en el que desea crear el segundo 

fotograma clave.
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 7. En la vista de escena o de cámara, util ice el cuadro del manipulador para transformar la capa de 

modo que tenga la posición, el ángulo y el tamaño que desea que tenga al final de la animación.

Se crea un fotograma clave en el fotograma actual al realizar la primera transformación.

 8. Desplace el cursor de la línea de tiempo al principio del panel.

 9. En la barra de herramientas de reproducción, haga clic en el botón Play (Reproducir)  para 

obtener una vista previa de la animación.
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Capítulo 13: Importación de audio

Puede agregar sonido a la animática. Una animática puede tener una o varias pistas de audio, y cada pista de 

audio puede tener uno o varios archivos de sonido en diferentes momentos del proyecto.

Cómo habilitar el sonido

De forma predeterminada, el sonido se deshabilita en Storyboard Pro. Debe habilitar el sonido para poder 

escuchar el audio del proyecto durante la reproducción.

Habilitación o deshabilitación de la reproducción de audio

 1. Realice una de las siguientes acciones:

 l En la barra de herramientas de reproducción, haga clic en el botón Sound (Sonido) .

 l En el menú superior, seleccione Play > Audio Playback (Reproducir > Reproducción de 

audio).

La próxima vez que reproduzca la animática, escuchará la reproducción de los clips de sonido de 

sus pistas de audio.

Importación de clips de sonido

Puede importar archivos de sonido en la pista de audio en la línea de tiempo del proyecto. Puede preparar y 

editar clips de sonido para que se sincronicen con la acción en la animática. De manera predeterminada, el 

proyecto tiene una sola pista de audio, pero se pueden agregar más pistas de audio según sea necesario.

Importación de un clip de sonido

 1. En la vista de línea de tiempo, seleccione la pista de audio en la que desea importar los clips de 

sonido.

 2. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Sound Clip (Archivo > Importar > Clip 

de sonido).

 l Haga clic con el botón derecho en la pista de audio en la que desee importar clips de 

sonido y, a continuación, seleccione Import Sound Clips (Importar clips de sonido).

 l Haga clic con el botón derecho en el espacio vacío situado debajo de las pistas en la 

vista de línea de tiempo y, a continuación, seleccione Import Sound Clips (Importar 

clips de sonido).

Se abre el cuadro de diálogo Import Sound Clips (Importar clips de sonido).
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 3. Haga clic en el botón Browse (Examinar) .

 4. En el buscador de archivos, localice y seleccione el archivo de sonido que desee agregar a su 

proyecto y haga clic en Open (Abrir).

 5. En el panel Target Audio Track (Pista de audio de destino), seleccione New Audio Track (Nueva 

pista de audio) si desea crear una nueva pista de audio e importar el archivo de sonido en ella, o 

Current Audio Track (Pista de audio actual) si desea importar el archivo de sonido en la pista de 

audio seleccionada.

 6. En la sección Target Frame (Fotograma objetivo), seleccione si desea agregar el clip de sonido al 

First Frame (Primer fotograma) de la pista de audio o al Current Frame (Fotograma actual), donde 

se encuentra el cursor de la línea de tiempo.

 7. Si ha seleccionado la opción Current Audio Track (Pista de audio actual) y si hay otros clips de 

audio en la pista de sonido de destino, especifique qué ocurrirá si el clip de sonido importado es 

demasiado largo y se expande a otro clip de sonido existente al seleccionar una Import Rule (Regla 

de importación):

 l Overwrite Existing Sound Clips (Sobrescribir clips de sonido existentes): Si ya hay clips de 

sonido donde se supone que se deben agregar los clips importados, los clips existentes se 

sobrescribirán.

 l Fill Next Available Frames (Rellenar siguientes fotogramas disponibles): Si ya hay clips de 

sonido donde se supone que se deben agregar los nuevos clips, los clips se ajustarán justo 

antes de los clips existentes.

 8. Seleccione la opción Set as default and don’t show dialogue again (Establecer como 

predeterminado y no volver a mostrar el diálogo) si desea util izar la misma configuración la 

próxima vez que necesite importar un archivo de sonido.

 9. Haga clic en OK (Aceptar).

Los archivos de sonido seleccionados se añadirán al proyecto como clips de sonido en la pista de 
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audio de destino seleccionada y en la posición seleccionada.

Importación de clips de sonido con arrastrar y colocar

 1. Abra la ventana del Explorador (W indows) o el Finder (macOS).

 2. Busque la ubicación de los elementos de archivos de sonido que desee exportar.

 3. Seleccione todos los elementos de archivos de sonido que desee importar.
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CONSEJO 

Puede seleccionar varios archivos mediante una de las siguientes acciones:

 l Mientras pulsa Ctrl (W indows/Linux) o ⌘  (macOS), haga clic en cada uno de los 

archivos que desee seleccionar.

 l Mientras pulsa Mayús, haga clic en el primer archivo que desee seleccionar y, a 

continuación, en el último archivo que desee seleccionar para seleccionar todos los 

archivos intermedios.

 4. Asegúrese de que tanto la ventana de Storyboard Pro como la ventana del Explorador o el Finder 

estén visibles.

 5. En la mitad inferior de la vista de línea de tiempo, desplácese verticalmente hasta la pista de audio 

en la que desea insertar los clips de sonido y, a continuación, desplácese horizontalmente hasta el 

punto en el que desea insertar los clips de sonido.

 6. En la ventana del Explorador o del Finder, haga clic y arrastre uno de los archivos seleccionados. 

Después, colóquelo en la pista de audio donde desee importarlo y en el momento en el que desee 

importarlo.

Los clips de sonido seleccionados se añadirán a la pista de audio de destino en el punto de la línea 

de tiempo en el que los colocó.

Adición de pistas de audio

Si necesita reproducir varios clips de sonido al mismo tiempo, debe agregar pistas de audio adicionales al 

proyecto para poder preparar varios clips de sonido en las mismas áreas de la línea de tiempo.
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Adición de una pista de audio

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Storyboard > New > New Audio Track (Storyboard > 

Nuevo > Nueva pista de audio).

 l En la vista de línea de tiempo, haga clic con el botón derecho en una pista de audio existente 

o debajo de todas las pistas y seleccione New Audio Track (Nueva pista de audio).

 l En la barra de herramientas de clips y pistas, haga clic en el botón New Audio Track (Nueva 

pista de audio) .

Ya puede importar o mover clips de sonido a la nueva pista de audio.
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Al crear un proyecto de Storyboard Pro, la única pista destinada a contener imágenes en la animática es la 

pista del storyboard. Sin embargo, también puede agregar pistas de vídeo al proyecto, que puede contener 

imágenes fijas o archivos de vídeo que se mostrarán por encima o por debajo de la animática. Esto puede ser 

útil si necesita util izar imágenes o vídeos de referencia para que elementos, como logotipos o fondos, se 

expandan por varios paneles o escenas, o para insertar en la animática vídeos, como secuencias de apertura, 

secuencias de créditos o material de acción en vivo.

A diferencia de las capas de un panel, los clips de las pistas de vídeo pueden abarcar varios paneles y no se 

ven afectados por los movimientos de la cámara.

Adición de pistas de vídeo

Al igual que los clips de sonido se deben añadir a las pistas de audio, los clips de vídeo se deben añadir a las 

pistas de vídeo. Por lo tanto, antes de que pueda agregar clips de vídeo a la animática, debe crear pistas de 

vídeo.

Al igual que las pistas de audio, puede agregar varias pistas de vídeo al proyecto y hacer que los clips se 

superpongan entre sí. También puede agregar pistas de vídeo encima o debajo de la pista del storyboard para 

que los vídeos aparezcan delante o detrás de la animática.

Adición de una pista de vídeo

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Storyboard > New > New Video Track (Storyboard > 

Nuevo > Nueva pista de vídeo).

 l En la vista de línea de tiempo, haga clic con el botón derecho en una pista de vídeo existente 

o en el espacio vacío que se encuentra por debajo de las pistas, y seleccione New Video 

Track (Nueva pista de vídeo).

 l En la barra de herramientas Clips and Tracks (Clips y pistas), haga clic en el botón New 

Video Track (Nueva pista de vídeo) .

Ya puede importar o mover clips de vídeo a la nueva pista de vídeo.
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 2. Si desea que la pista de vídeo se muestre detrás de la animática, haga clic con el botón derecho en 

la pista de vídeo y seleccione Move Track Down (Bajar pista).

Importación de clips de vídeo

Una vez que tenga una pista de vídeo, puede importar clips de imagen o vídeo a esta pista.

Importación de un clip de vídeo o de imagen utilizando el cuadro de diálogo Import 
Videos/Images (Importar vídeos/imágenes)

 1. Si desea importar clips en una pista de vídeo existente, seleccione la pista de vídeo en la que desee 

importar clips en la vista de línea de tiempo.

 2. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Videos/Images as Clip (Archivo > Importar 

> Vídeos/imágenes como clip).

 l Haga clic con el botón derecho en la pista de vídeo en la que desee importar clips y, a 

continuación, seleccione Import Videos/Images as Clips (Importar vídeos/imágenes como 

clip).

 l Haga clic con el botón derecho en el espacio vacío situado debajo o encima de las pistas en 

la vista de línea de tiempo y, a continuación, seleccione Import Videos/Images as Clips 

(Importar vídeos/imágenes como clip).

Se abre el cuadro de diálogo Import Video Clips (Importar clips de vídeo).
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 3. Haga clic en el botón Browse (Examinar) .

 4. En el explorador de archivos, localice y seleccione el archivo de imagen o vídeo que desee agregar 

a su proyecto y, a continuación, haga clic en Open (Abrir).

 5. En el panel Destination (Destino), seleccione New Video Track (Nueva pista de vídeo) si el 

proyecto no tiene una pista de vídeo o si desea importar el clip en una nueva pista de vídeo, o 

Current Video Track (Pista de vídeo actual) si desea importarlo en la pista de vídeo actualmente 

seleccionada.

 6. Si ha seleccionado una imagen, establezca la duración deseada de la imagen fija en el campo Still 

Images Duration (Duración de imágenes estáticas). Esto determina la cantidad de fotogramas por 

los que se expandirá el clip de imagen en la línea de tiempo. Por ejemplo, si los fotogramas por 

segundo del proyecto son 24 y desea que la imagen abarque 1 segundo, defina 24 en Clips 

Duration (Duración de clips).

 7. Si ha seleccionado un archivo de película con transparencia, seleccione el tipo de alfa adecuado 

para el mismo en la lista desplegable Alpha Type (Tipo de alfa):

Esta opción le permite informar a Storyboard Pro de cómo se han codificado los píxeles 

transparentes y semitransparentes de su clip para que se mezclen adecuadamente con los demás 

elementos visuales de su animática.

 l Ignore Alpha (Ignorar alfa): Mostrar cada píxel del clip de vídeo como opaco, sin 

desmultiplicar sus valores de color o mezclarlos con otros elementos visuales de la 

animática.

 l Premultiplied with Black (Premultiplicado con negro): Los valores de color de los píxeles 

semitransparentes del vídeo se han codificado de modo que, cuanto más transparentes 

sean, más cercanos al negro estarán. Cuando se carga un vídeo premultiplicado con negro 

en un software que no admite transparencia, aparece combinado con un fondo negro. 

Seleccione esta opción para hacer que Storyboard Pro revierta esta premultiplicación de 

modo que el vídeo se combine correctamente con otros elementos visuales de la animática.

 l Premultiplied with W hite (Premultiplicado con blanco): Los valores de color de los píxeles 

semitransparentes del vídeo se han codificado de modo que, cuanto más transparentes 

sean, más cercanos al blanco estarán. Cuando se carga un vídeo premultiplicado con blanco 

en un software que no admite transparencia, aparece combinado con un fondo blanco. 

Seleccione esta opción para hacer que Storyboard Pro revierta esta premultiplicación de 

modo que el vídeo se combine correctamente con otros elementos visuales de la animática.

 l Straight (Recto): El color de los píxeles semitransparentes en la imagen se codifica 

independientemente de su transparencia. Cuando se carga un clip de vídeo que no está 

premultiplicado en un software que no admite transparencia, los píxeles semitransparentes 
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simplemente aparecen completamente opacos, lo cual hace que sus bordes parezcan 

pixelados.

CONSEJO 

Si no sabe con seguridad el tipo de alfa del archivo de película, seleccione Straight 

(Directo). A continuación, una vez importados los clips, véalos en la vista de escena. Si 

los píxeles transparentes de la película parecen demasiado oscuros, cambie el tipo de 

alfa del clip a Premultiplied with Black (Premultiplicado con negro). Si los píxeles 

transparentes de la película parecen demasiado claros, cambie el tipo de alfa del clip a 

Premultiplied with W hite (Premultiplicado con blanco).

Puede cambiar el tipo de alfa de un clip de vídeo haciendo clic con el botón derecho en 

el clip en la vista de línea de tiempo y, a continuación, seleccionando Alpha Type (Tipo 

de alfa) en el menú contextual.

 8. Si el archivo de película tiene una pista de audio y desea importarla en el proyecto, active la casilla 

de verificación Import Audio (Importar audio).

 9. Si ha activado la casilla de verificación Import Audio (Importar audio), realice una de las siguientes 

acciones:

 l Si desea crear una nueva pista de audio en el proyecto en la que importar la pista de audio 

de la película, seleccione New Audio Tracks (Nuevas pistas de audio).

 l Si desea importar la pista de audio de la película en una pista de audio existente en el 

proyecto, seleccione Existing Audio Track (Pista de audio existente). A continuación, en la 

lista desplegable situada debajo, seleccione en qué pista de audio del proyecto desea 

importar la pista de audio de la película.

 10. Si ha seleccionado la opción Current Video Track (Pista de vídeo actual) y si hay otros clips de 

vídeo en la pista de vídeo de destino, especifique qué ocurrirá si el clip de vídeo importado es 

demasiado largo y se expande por otros clips existentes al seleccionar una Import Rule (Regla de 

importación):

 l Overwrite Existing Clips (Sobrescribir clips existentes): Si ya hay clips de vídeo donde se 

insertan los clips importados, los clips existentes se sobrescribirán.
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 l Fill Next Available Frames (Rellenar siguientes fotogramas disponibles): Si ya hay clips de 

vídeo donde se insertan los nuevos clips, los clips se ajustarán justo antes de los clips 

existentes.

 11. Haga clic en OK (Aceptar).

El archivo de vídeo se añadirá al proyecto como un clip de vídeo en la pista de vídeo de destino 

seleccionada.

Importación de clips de vídeo o de imagen con arrastrar y colocar

 1. Abra la ventana del Explorador (W indows) o el Finder (macOS).

 2. Busque la ubicación de los elementos de archivos de vídeo o de imagen que desee exportar.

 3. Seleccione todos los elementos de archivos de vídeo o de imagen que desee importar.
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CONSEJO 

Puede seleccionar varios archivos mediante una de las siguientes acciones:

 l Mientras pulsa Ctrl (W indows/Linux) o ⌘  (macOS), haga clic en cada uno de los 

archivos que desee seleccionar.

 l Mientras pulsa Mayús, haga clic en el primer archivo que desee seleccionar y, a 

continuación, en el último archivo que desee seleccionar para seleccionar todos los 

archivos intermedios.

 4. Asegúrese de que tanto la ventana de Storyboard Pro como la ventana del Explorador o el Finder 

estén visibles.

 5. En la mitad superior de la vista de Timeline (Línea de tiempo), desplácese verticalmente a la pista 

de vídeo en la que desea importar sus clips. A continuación, desplácese horizontalmente hasta el 

punto en el que desee insertar estos clips.

 6. En la ventana del explorador o del Finder, haga clic y arrastre uno de los archivos seleccionados. 

Después, colóquelo en la pista de audio donde desee importarlo y en el momento en el que desee 

importarlo.

Los archivos seleccionados se añadirán como clips de vídeo a la pista de vídeo de destino en el 

punto de la línea de tiempo en el que los colocó.
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Storyboard Pro permite manipular capas de dibujo en el espacio 3D e integrar modelos 3D en el storyboard. Si 

el proyecto util iza modelos 3D, puede importarlos en el proyecto y, a continuación, insertarlos en los paneles 

en lugar de tener que dibujarlos.

Conversión de una escena en 3D

Al crear una escena, se crea en modo 2D de forma predeterminada. Esto significa que las capas están 

bloqueadas en la misma posición en el eje z y solo se pueden rotar sobre el eje z. De este modo se evita 

obstaculizar el flujo de trabajo con funciones 3D que no son necesarias.

Puede convertir fácilmente una escena 2D a 3D, y viceversa. En una escena 3D, puede mover capas en el eje z 

y rotarlas en cualquier dirección. También puede rotar la cámara en cualquier dirección y hacer que se mueva a 

través de la profundidad de la escena. Del mismo modo, puede rotar la vista de escena en cualquier ángulo y 

desplazarse por la escena detenidamente, lo que le permite verla desde diversos puntos de vista.

NOTA 

Puede convertir una escena en 3D, pero no un solo panel. Al cambiar al modo 3D, este solo se 

aplica a la escena actual, no a todo el proyecto.

Activación de la opción 3D

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione la escena que desea convertir 

en 3D.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas de storyboard, haga clic en el botón Enable 3D (Habilitar 3D) 
.

 l Seleccione Storyboard > Enable 3D for Current Scene (Storyboard > Habilitar 3D para 

escena actual).

Restablecimiento de una escena a 2D

Puede restablecer una escena 3D a 2D. Al hacerlo, se realizan los siguientes cambios en la escena:

 l Se eliminan los modelos 3D importados.

 l Los movimientos de cámara 3D se convierten en movimientos de cámara 2D. Los movimientos de la 

cámara en el eje z se convertirán en acercamientos y alejamientos de la cámara 2D, pero se ignorarán 

las rotaciones 3D.
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 l Las transformaciones 3D en capas se convierten en transformaciones 2D. Las capas que se han movido 

en el eje z aumentarán o disminuirán de tamaño para conservar sus proporciones aparentes, pero se 

ignorarán las rotaciones 3D.

Restablecimiento de una escena a 2D

 1. Realice una de las siguientes acciones:

 l En la barra de herramientas Storyboard, haga clic en el botón Reset Scene to 2D 

(Restablecer escena a 2D) .

 l Seleccione Storyboard > Reset Scene to 2D (Storyboard > Restablecer escena a 2D).

Visualización de objetos desde la parte superior y lateral

Al trabajar en 3D, se puede util izar la vista de escena para mirar la escena desde cualquier punto de vista y 

desde cualquier ángulo. Esto permite ver cómo están colocados los objetos en el espacio, y puede util izar la 

vista de cámara para ver la escena desde el punto de vista de la cámara. Sin embargo, es probable que a 

menudo necesite tener un control preciso sobre cómo se colocan los objetos y las capas en el eje z.

Las vistas superior y lateral permiten ver la escena desde su parte superior y lateral, respectivamente. Dado 

que estas vistas no aplican perspectiva a la escena, se pueden util izar para colocar elementos con más 

precisión. Con la vista lateral, puede ver y colocar capas y objetos en el eje delantero-trasero (z), así como en 

el eje norte-sur (y). Con la vista superior, puede ver y colocar capas y objetos en el eje delantero-trasero (z), así 

como en el eje este-oeste (x). Por lo tanto, ambas vistas combinadas pueden ayudar a colocar objetos en el eje 

z sin perder de vista su posición en los otros ejes.

Las vistas superior y lateral muestran capas 2D como segmentos finos, como si estuviera mirando las hojas de 

papel desde un lateral. Puede seleccionar y manipular capas 2D de forma manual directamente desde estas 

vistas.
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Visualización de las vistas superior o lateral

 l En la esquina superior derecha de cualquier vista, haga clic en el botón  Add View (Agregar 

vista) y seleccione Side View (Vista lateral) o Top View (Vista superior).

 l En el menú superior, seleccione W indows > Side View (Ventanas > Vista superior) o Top View 

(Vista lateral).

Colocación de elementos 2D en el espacio 3D

En una escena 3D, las capas de dibujo se pueden manipular como objetos 3D. Puede colocarlas más cerca o 

más lejos de la cámara para crear un efecto de multiplano. También puede rotarlas en cualquier dirección para 

realizar falsas construcciones 3D, como habitaciones abiertas.

Colocación de un elemento 2D en el espacio 3D

 1. En la barra de herramientas de herramientas, seleccione el botón Layer Transform (Transformación 

de capas) .

 2. En la vista de escena, seleccione el elemento que desea cambiar de lugar.

Aparece un manipulador de transformación 3D sobre la capa en las vistas de escena, cámara, 

superior y lateral.

 3. Este manipulador 3D tiene una flecha azul en la que puede hacer clic y arrastrarla para mover la 

capa en el eje z. Sin embargo, dado que esta flecha azul se encuentra directamente frente a la vista 
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de escena, no puede hacer clic y arrastrarla. En su lugar, debe seguir uno de los siguientes 

enfoques:

 l Haga clic y arrastre la flecha azul en la vista superior o en la vista lateral. Si arrastra la capa 

más cerca de la punta del cono de la cámara, se acercará a la cámara y se mostrará más 

grande. Si la arrastra desde la punta del cono de la cámara, estará más atrás y se mostrará 

más pequeña.

 l Rote el punto de vista de la vista de escena manteniendo pulsadas las teclas Ctrl + Mayús 

(W indows) o mayúsculas + ⌘  (macOS) y, a continuación, haciendo clic y arrastrando la 

vista. Cuando la vista de escena se encuentre en cualquier ángulo que no sea el 

predeterminado, podrá hacer clic y arrastrar la flecha azul, y mover la capa a través del eje z.

Al arrastrar el elemento por el espacio 3D, la posición del elemento también se actualizará en las 

otras vistas.
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Importación de modelos 3D

Puede integrar modelos 3D en el proyecto importándolos en la librería y, a continuación, arrastrándolos y 

colocándolos en los paneles donde sean necesarios. Cada proyecto de Storyboard Pro tiene su propia librería 

de modelos 3D. Como cada instancia del modelo proviene de la librería del proyecto, Storyboard Pro no tiene 

que almacenar una copia del modelo para cada panel que lo util ice.

Storyboard Pro admite los siguientes tipos de modelos 3D:

 l Filmbox (.fbx)

 l 3DS Max (.3ds)

 l W avefront OBJ (.obj)

 l Allembic (.abc)

 l Collada (.dae)

NOTA 

Se recomienda util izar el formato Filmbox (.fbx), ya que se puede empaquetar con texturas 

integradas en el modelo.

Importación de un objeto 3D en la librería

 1. En la vista de librería, haga clic con el botón derecho en la carpeta de la librería de modelos 3D y 

seleccione Import Files (Importar archivos).

 2. En el buscador de archivos, localice y seleccione el modelo 3D y haga clic en Open (Abrir).

Aparece el siguiente aviso.

Si lo desea, puede importar el modelo en su formato original. Sin embargo, si lo convierte a FBX, se 

asegurará de que sus texturas se consoliden con el modelo del proyecto.

 3. Haga clic en OK (Aceptar).

El modelo seleccionado aparece en la carpeta de modelos 3D de la vista de librería.
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 4. Arrastre y coloque el modelo 3D de la vista de librería a la vista de escena o de cámara:

 l Para insertarlo entre dos capas específicas, colóquelo entre esas capas en el panel Layer 

(Capa) de la vista de escena o de cámara. 

 l Si desea insertarlo sobre todas las demás capas, puede colocarlo directamente en la vista de 

escena o de cámara. 

El modelo 3D se inserta en el panel con su tamaño original y en el centro de la escena. Se añade 

una capa para el modelo 3D a la lista de capas.

NOTA 

Si elimina un modelo 3D de la biblioteca, se eliminarán del proyecto todas las instancias de 

ese modelo.

Manipulación de objetos 3D

Si selecciona un modelo 3D con la herramienta Layer Transform (Transformación de capa) , aparecerá un 

manipulador de transformación 3D sobre el modelo en las vistas de escena, cámara, superior y lateral. El 

manipulador de transformación para modelos 3D es un cubo con controles para mover, rotar y escalar el 

modelo sobre cualquiera de los tres ejes.

Un modelo 3D que se acaba de importar en un panel estará orientado a la cámara. En consecuencia, el cubo de 

su manipulador 3D también estará orientado a la cámara, lo que le proporcionará un aspecto de cuadrado. En 

este ángulo, no podrá mover ni escalar el modelo sobre el eje z. Para solucionarlo, debe rotar la vista de 

escena, util izar las vistas superior o lateral, o rotar el propio modelo.
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Rotación de la vista de escena en 3D

 1. Realice una de las siguientes acciones:

 l En la barra de herramientas de herramientas, haga doble clic en la herramienta Hand (Mano) 
 y seleccione la herramienta 3D Navigation (Navegación 3D) .

 l Mantenga pulsado Ctrl + Mayús (W indows) o mayúsculas + ⌘  (macOS).

 2. Haga clic y arrastre el interior de la vista de escena para rotarlo en todas las direcciones.

Manipulación de un objeto 3D

 1. En la barra de herramientas de herramientas, seleccione la herramienta Layer Transform 

(Transformación de capas) .

 2. Seleccione el modelo 3D que desea manipular.

 3. En las vistas de escena, cámara, superior o lateral, realice una de las siguientes acciones:

 l Para trasladar el modelo al eje x, haga clic y arrastre la flecha roja.

 l Para trasladar el modelo al eje y, haga clic y arrastre la flecha verde.

 l Para trasladar el modelo al eje z, haga clic y arrastre la flecha azul.

 l Para trasladar el modelo lateralmente en relación con su punto de vista, haga clic y arrastre 

su geometría.
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 l Para rotar el modelo sobre el eje x, haga clic y arrastre el círculo rojo.

 l Para rotar el modelo sobre el eje y, haga clic y arrastre el círculo verde.

 l Para rotar el modelo sobre el eje z, haga clic y arrastre el círculo azul.

 l Para rotar el modelo en cualquier dirección, haga clic y arrastre sobre su círculo externo.

 l Para escalar el modelo sobre el eje x, haga clic y arrastre sobre el punto cuadrado rojo.

 l Para escalar el modelo sobre el eje y, haga clic y arrastre sobre el punto cuadrado verde.

 l Para escalar el modelo sobre el eje z, haga clic y arrastre sobre el punto cuadrado azul.

 l Para escalar el modelo sobre todos los ejes, haga clic y arrastre cualquier vértice del cubo.
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CONSEJO 

Si necesita rotar o escalar el modelo 3D desde un punto pivote específico, puede mover 

el punto pivote del modelo 3D haciendo clic y arrastrando el pivote  del centro del 

manipulador. El manipulador y su pivote se moverán, pero no el modelo.

Vista previa de escenas 3D

En Storyboard Pro, la vista de escena es la vista predeterminada para dibujar y manipular objetos. Sin 

embargo, cuando se trabaja en 3D, se presenta una dificultad: al panear, rotar, acercar o alejar la vista de 

escena, cambiará el punto de vista desde el que mira la escena. Esto significa que es posible que la posición 

aparente y el tamaño de los elementos no sean representativos de lo que aparecerá en el storyboard o la 

animática.

Si desea ver una escena 3D exactamente tal y como se verá en el storyboard, debe util izar la vista de cámara. 

La vista de cámara siempre muestra la escena desde el punto de vista de la cámara, incluso si la panea, la rota 

o la acerca o aleja. Por lo tanto, siempre se debe obtener una vista previa de la escena desde la vista de 

cámara si se realizan cambios en la posición de la cámara o de los objetos 3D para asegurarse de que la 

composición de la escena sea la esperada.
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Adición de la vista de cámara al espacio de trabajo

 1. Realice una de las siguientes acciones:

 l En la esquina superior derecha de la vista de escena, haga clic en el botón  Add View 

(Agregar vista) y, a continuación, seleccione Camera View (Vista de cámara).

 l En el menú superior, seleccione W indows > Camera View (Ventanas > Vista de cámara).
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Capítulo 16: Creación e importación de plantillas

Una plantil la es una copia que realiza el usuario de una o varias capas, o de uno o varios paneles, en una 

librería. Una vez que haya creado una plantil la, puede volver a importarla tantas veces como necesite, ya sea 

en el mismo proyecto o en un proyecto diferente.

NOTA 

Al crear una plantil la, no está vinculada al proyecto original. Se crea una copia de los recursos para 

la plantil la y puede modificar el proyecto original sin que afecte a la plantil la. Del mismo modo, al 

importar una plantil la en el proyecto, se copia en el mismo. La realización de cambios en la 

plantil la no afectará a las copias importadas y puede realizar cambios en los recursos importados 

sin que ello afecte a la plantil la.

Creación de plantillas de capas

Puede crear una plantil la de una o varias capas desde el panel Layer (Capa) en la vista de escena o de cámara.

Creación de una plantilla de una o varias capas utilizando la vista de escena o de 
cámara

 1. En la vista de librería, seleccione una carpeta en la que desee almacenar la plantil la.

 2. En el panel de capas de la vista de escena o de cámara, seleccione una o varias capas. Para 

seleccionar varias capas, realice una de las siguientes acciones:

 l Mientras mantiene pulsada la tecla Mayús, haga clic en la primera capa que desee agregar a 

la selección y, a continuación, en la última capa que desee agregar. Todas las capas 

intermedias formarán parte de la selección.

 l Mientras mantiene pulsada la tecla Ctrl (W indows) o ⌘  (macOS), haga clic en cada capa 

que desee agregar a la selección. 

 3. Arrastre y coloque la selección en el panel derecho de la vista de librería.

 4. En el cuadro de diálogo Rename (Cambiar nombre), introduzca el nombre de la nueva plantil la.
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NOTA 

También puede cambiar el nombre de una plantil la después de crearla haciendo clic con el 

botón derecho sobre ella y seleccionando Rename (Cambiar nombre).

Importación de plantillas de capas

Puede importar una plantil la de capas en un panel util izando la vista de escena o de cámara.

Importación de capas de una plantilla en un panel

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione el panel en el que desea 

insertar la plantil la.

 2. En la vista de librería, seleccione la plantil la que desea importar.

 3. Arrastre y coloque la plantil la en la vista de escena o de cámara:

 l Para insertarlo entre dos capas específicas, colóquelo entre esas capas en el panel Layer 

(Capa) de la vista de escena o de cámara. 

 l Si desea insertarlo sobre las demás capas, puede colocarlo directamente en la vista de 

escena o de cámara. 

Creación de plantillas de paneles

Puede crear una plantil la de uno o varios paneles util izando la vista de imágenes en miniatura o de línea de 

tiempo.

Creación de una plantilla de uno o varios paneles mediante la vista de imágenes en 
miniatura

 1. En la vista de librería, seleccione una carpeta en la que desee almacenar la plantil la.
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 2. En la vista de imágenes en miniatura, seleccione uno o varios paneles. Para seleccionar varios 

paneles, realice una de las siguientes acciones:

 l Mientras mantiene pulsada la tecla Ctrl (W indows) o ⌘  (macOS), haga clic en cada panel 

que desee agregar a la selección.

 l Mientras mantiene pulsada la tecla Mayús, haga clic en el primer panel que desee agregar a 

la selección y, a continuación, en el último panel que desee agregar. Los dos paneles en los 

que ha hecho clic y todos los paneles intermedios se agregarán a la selección.

 3. Haga clic y arrastre el controlador de arrastrar y colocar  de uno de los paneles seleccionados y, a 

continuación, coloque la selección en el panel derecho de la vista de librería.

 4. En el cuadro de diálogo Rename (Cambiar nombre), cambie el nombre de la nueva plantil la.

NOTA 

También puede cambiar el nombre de una plantil la después de crearla haciendo clic con el 

botón derecho sobre ella y seleccionando Rename (Cambiar nombre).

Creación de una plantilla de uno o varios paneles mediante la vista de línea de tiempo

 1. En la vista de librería, seleccione una carpeta en la que desee almacenar la plantil la.

 2. En la vista de línea de tiempo, seleccione uno o varios paneles. Para seleccionar varios paneles, 

realice una de las siguientes acciones:
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 l Mientras mantiene pulsada la tecla Ctrl (W indows) o ⌘  (macOS), haga clic en cada panel 

que desee agregar a la selección.

 l Mientras mantiene pulsada la tecla Mayús, haga clic en el primer panel que desee agregar a 

la selección y, a continuación, en el último panel que desee agregar. Los dos paneles en los 

que ha hecho clic y todos los paneles intermedios se agregarán a la selección.

 3. Arrastre y coloque los paneles seleccionados en el panel derecho de la vista de librería.

 4. En el cuadro de diálogo Rename (Cambiar nombre), introduzca el nombre de la nueva plantil la.

NOTA 

También puede cambiar el nombre de una plantil la después de crearla haciendo clic con el 

botón derecho sobre ella y seleccionando Rename (Cambiar nombre).

Importación de plantillas de paneles

Puede importar una plantil la de panel en la vista de imágenes en miniatura o de línea de tiempo.

Inserción de una plantilla de paneles entre dos paneles en la vista de imágenes en 
miniatura

 1. En la vista de librería, seleccione la plantil la que desea importar.

 2. Arrastre y coloque la plantil la seleccionada en la vista de imágenes en miniatura, entre los dos 

paneles en los que desee que se inserte.
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NOTA 

Si está insertando la plantil la entre dos escenas, puede elegir si el panel se adjuntará a la 

escena anterior o a la siguiente, o si se insertará en su propia escena. Esto dependerá de lo 

cerca que esté de cada escena o del espacio entre ellas en el que coloque la plantil la. A 

medida que mueva el panel en el espacio, una línea roja indicará dónde terminará el panel.

Inserción de una plantilla de paneles entre dos paneles en la vista de línea de tiempo

 1. En la vista de librería, seleccione la plantil la que desea importar.

 2. Arrastre la plantil la seleccionada en la vista de línea de tiempo, entre los dos paneles en los que 

desea que se inserte.
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NOTA 

Si está insertando la plantil la entre dos escenas, puede elegir si el panel se adjuntará a la 

escena anterior o a la siguiente, o si se insertará en su propia escena. Esto dependerá de lo 

cerca que esté de cada escena en la que coloque la plantil la. A medida que mueva el panel 

cerca de la junta entre las escenas, un corchete verde indicará dónde terminará el panel.
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Capítulo 17: Exportación del proyecto

Una vez que haya terminado el storyboard o la animática, puede exportarlo para pasar a la siguiente fase de la 

producción.

Si se fija en el menú superior File > Export (Archivo > Exportar), verá que existen muchas formas de exportar 

el proyecto. En este capítulo se presentarán los tres tipos de exportación que más se util izan:

 l PDF: Al exportar el storyboard como un formato de documento portátil (.pdf), se crea un documento 

que contiene un storyboard de animación tradicional que presenta cada panel en orden cronológico, con 

sus números de escena y panel, así como sus cuadros de texto. En este formato, puede imprimirlo o 

compartirlo digitalmente, y se puede usar como referencia o como material de presentación.

 l Movie (Película): Al exportar la animática como una película, puede compartirla con los colaboradores 

del proyecto e importarla en un software de terceros.

 l Harmony: Puede exportar cada escena de la animática en escenas independientes de Toon Boom 

Harmony, con los paneles insertados en las escenas para que se puedan usar como referencia para 

crear la animación. Si tiene la intención de crear la animación en Storyboard Pro, esta acción permite 

pasar rápidamente la producción de la fase de creación de storyboard a la animación.

Exportación de un PDF

La exportación de un PDF creará un storyboard de animación tradicional que muestra los paneles junto con su 

número de escena y panel, y sus cuadros de texto.

NOTA 

Para visualizar un archivo PDF se requiere un lector de PDF, como Adobe Reader, que puede 

descargar de la siguiente página: https://get.adobe.com/reader/

Exportación de un PDF

 1. En el menú superior, seleccione File > Export > PDF (Archivo > Exportar > PDF).

Se abre el cuadro de diálogo Export to PDF (Exportar a PDF).
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 2. En la sección Destination Path (Ruta de destino), haga clic en el botón Browse (Examinar) .

 3. En el cuadro de diálogo Save (Guardar), examine la ubicación a la que desee exportar el documento 

PDF. En el campo File name (Nombre de archivo), escriba el nombre deseado para el documento y 

haga clic en Save (Guardar).

 4. En la sección PDF Export Parameters (Parámetros de exportación de PDF), seleccione un layout 

para el archivo PDF.

 5. En la sección Export Range (Intervalo de exportación), seleccione si desea exportar todo el 

proyecto o solo partes específicas:
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 l All (Todo): Exporta el storyboard completo.

 l Selected Scenes (Escenas seleccionadas): Seleccione esta opción para exportar una 

selección específica de escenas. A continuación, haga clic en el botón Select (Seleccionar) 

para abrir el cuadro de diálogo Scenes Picker (Selector de escenas), en el que puede:

 l Escriba el número de una secuencia o de una escena en los campos Sequence 

(Secuencia) o Scene (Escena) de la sección Filter (Filtrar) para que se muestren 

únicamente las secuencias o escenas de la lista que coincidan.

 l Haga clic y arrastre para seleccionar un rango de escenas.

 l Mantenga pulsada la tecla Ctrl y haga clic en cada escena que desee agregar a la 

selección.

 l Mantenga pulsada la tecla Mayús y, a continuación, haga clic en la primera y en la 

última escena que desee agregar a la selección para seleccionar cada escena que 

haya entre esas dos, ambas incluidas.

 l Si el proyecto tiene secuencias, haga clic en una secuencia para seleccionar cada 

escena de dicha secuencia.

 l Current Scene (Escena actual): Exporta solo la escena seleccionada.

 l Current Panel (Panel actual): Exporta solo el panel seleccionado actualmente.

 l Tracked Panels (Paneles de seguimiento): Exporta paneles en los que está habilitado el 

control de cambios.

 6. Si desea ver el storyboard después de haberlo exportado, active la opción Open document after 

export (Abrir documento tras exportación).

 7. Haga clic en el botón Export (Exportar).

Exportación de una película

Una vez que haya creado el storyboard y la animática, puede exportarlos como un archivo de película para 

compartirlos con los colaboradores del proyecto o importarlos en un software de terceros. Puede exportar la 

animática como un archivo de vídeo con audio o como una secuencia de archivos de imagen. Esta última se 

puede ensamblar en Harmony o en un software de terceros.

Exportación de una película

 1. En el menú superior, seleccione File > Export > Movie (Archivo > Exportar > Película).

Se abre el cuadro de diálogo Export to Movie (Exportar a película).
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Capítulo 17: Exportación del proyecto

 2. En la sección Destination Path (Ruta de destino), haga clic en el botón Browse (Examinar)  y 

elija la carpeta en la que desee guardar los archivos exportados.

 3. En el campo File Pattern (Patrón de archivo), escriba un prefijo para los archivos exportados si 

tiene previsto exportar una secuencia de imágenes.

 4. En la sección Export Movie Format (Exportar formato de película), configure las siguientes 

opciones:
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 a. En la lista desplegable Movie Format (Formato de película), seleccione un formato de 

exportación:

 l QuickTime Movie (*.mov): formato de Apple QuickTime. Este es el formato de 

exportación predeterminado que se recomienda por su portabilidad y porque le 

permite elegir entre varios códecs de vídeo.

NOTAS 

 l En W indows, se debe instalar QuickTime de Apple para que 

Storyboard Pro pueda exportar películas de QuickTime. Puede 

configurar que las películas de QuickTime util icen cualquier códec 

compatible con QuickTime, incluidos H.264, MPEG-4 y Animation, 

para su exportación.

 l En macOS, Storyboard Pro util iza Apple AVFoundation para exportar 

películas de QuickTime, lo que le permite util izar códecs como H.264, 

Apple ProRes 422 y Apple ProRes 4444.

 l Si desea exportar una película de QuickTime con transparencia, 

asegúrese de elegir un códec que admita la codificación con un canal 

alfa.

 l H.264/MPEG-4 (*.mov): formato de película sencillo que util iza el códec H.264 

compatible con la mayoría de navegadores web.

NOTAS 

 l El uso de este formato no requiere software adicional. Sin embargo, si 

es la primera vez que exporta una película en formato H.264/MPEG-4, 

se le solicitará que descargue la librería OpenH264 de Cisco. 

Simplemente haga clic en Yes (Sí) cuando se le solicite y Storyboard 

Pro descargará la librería automáticamente y, a continuación, 

exportará la película.

 l No hay opciones de codificación para este formato.

 l Este formato admite resoluciones de hasta 4096×2304. Cada 

dimensión debe ser un múltiplo de 16 píxeles.

 l El audio exportado en este formato está codificado en PCM estéreo de 

16 bits y 22,05 kHz.

 l W indows Media Video (*.wmv): formato nativo para W indows Media Player.
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NOTAS 

 l Los archivos W indows Media Video (.wmv) solo se pueden exportar 

en W indows.

 l Los reproductores de vídeo y editores en sistemas que no sean de 

W indows normalmente no pueden abrir archivos W indows Media 

Video (.wmv).

 l Flash (.swf)

 l Secuencia de imagen en formato Jpeg (*.jpg), Targa (*.tga) o Portable Network 

Graphics (*.png).

 b. La opciónTransparent Background (Fondo transparente) solo está disponible para los 

formatos QuickTime Movie (.mov), Targa (.tga) y Portable Network Graphic (.png). Active 

esta casilla si desea exportar su película o secuencia de imágenes con un fondo 

transparente.

 c. En la lista desplegable Resolution (Resolución), seleccione si desea que la película 

exportada tenga el tamaño Full Size (Tamaño completo), Half Size (Tamaño de mitad) o 

Quarter Size (Tamaño de cuarto) en relación con la resolución del proyecto. Se recomienda 

exportar la animática en tamaño completo, a menos que desee exportar rápidamente un 

vídeo de prueba.

 d. En el menú desplegable Colour Space (Espacio de color), seleccione un espacio de color 

diferente en el que desee exportar la película, o permanezca en Project W orking Colour 

Space (Espacio de color de trabajo del proyecto) predeterminado.

 e. En la lista desplegable One Clip (Un clip), seleccione cómo desea que se separen los clips 

de vídeo:

 l Per Scene (Por escena): Crear un archivo de película para cada escena del proyecto.

 l Per Sequence (Por secuencia): Crear un archivo de película para cada secuencia del 

proyecto, si la hubiera.

 l Per Project (Por proyecto): Exportar toda la animática en un solo archivo de vídeo.

 5. En la sección Export Range (Intervalo de exportación), seleccione si desea exportar todo el 

proyecto o solo partes específicas:

 l All (Todo): Exporta el storyboard completo.

 l Selected Scenes (Escenas seleccionadas): Seleccione esta opción para exportar una 

selección específica de escenas. A continuación, haga clic en el botón Select (Seleccionar) 

para abrir el cuadro de diálogo Scenes Picker (Selector de escenas), en el que puede:
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 l Escriba el número de una secuencia o de una escena en los campos Sequence 

(Secuencia) o Scene (Escena) de la sección Filter (Filtrar) para que se muestren 

únicamente las secuencias o escenas de la lista que coincidan.

 l Haga clic y arrastre para seleccionar un rango de escenas.

 l Mantenga pulsada la tecla Ctrl y haga clic en cada escena que desee agregar a la 

selección.

 l Mantenga pulsada la tecla Mayús y, a continuación, haga clic en la primera y en la 

última escena que desee agregar a la selección para seleccionar cada escena que 

haya entre esas dos, ambas incluidas.

 l Si el proyecto tiene secuencias, haga clic en una secuencia para seleccionar cada 

escena de dicha secuencia.

 l Current Scene (Escena actual): Exporta solo la escena seleccionada.

 l Current Panel (Panel actual): Exporta solo el panel seleccionado actualmente.

 l Tracked Panels (Paneles de seguimiento): Exporta paneles en los que está habilitado el 

control de cambios.

 6. Si desea reproducir automáticamente el vídeo o ver los archivos exportados una vez realizada la 

exportación, active la opción Open document/folder after export (Abrir documento/carpeta tras 

exportación).

 7. Haga clic en el botón Export (Exportar).

Exportación a Harmony

Storyboard Pro puede exportar automáticamente cada escena del proyecto en una escena que se puede abrir 

en Harmony, donde puede util izar la animática para crear y programar la animación. Las escenas de Harmony 

resultantes tendrán la misma longitud que las escenas del proyecto de Storyboard Pro. Contendrán cada uno 

de sus paneles para que pueda animar sobre ellos, y contendrán su parte correspondiente de la pista de 

sonido de la animática.

Exportación de escenas de Harmony

 1. En el menú superior, seleccione File > Export > Export to Harmony (Archivo > Exportar > Exportar 

a Harmony).
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Se abre el cuadro de diálogo Export to Harmony (Exportar a Harmony).

 2. En la sección Destination Path (Ruta de destino), haga clic en el botón Browse (Examinar)  y 

elija la carpeta en la que desee guardar los archivos exportados.

 3. En el campo File Pattern (Patrón de archivo), escriba un prefijo para los archivos exportados si 

tiene previsto exportar una secuencia de imágenes.

 4. En la lista desplegable Format (Formato), seleccione una de las siguientes opciones:

 l Harmony Offline (Harmony sin conexión): Creará escenas que se pueden abrir en  Harmony 

Stand Alone.

 l Harmony Database (Base de datos de Harmony): Creará un paquete de escenas que se 

puede importar en una base de datos de Harmony Server.

 5. Seleccione uno de los siguientes tipos de exportación dependiendo de la herramienta con la que 

prefiera trabajar.

 l Rendered Animatic (Animática renderizada): Renderiza la animática en una secuencia de 

imágenes de mapa de bits agrupadas en las escenas de Harmony exportadas. Así se 
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garantiza que el contenido de la animática se renderice con precisión en Harmony, sobre 

todo si tiene la intención de util izar una versión anterior.

 l Escena original: Exporta la animática directamente en escenas de Harmony sin renderizarla. 

Así se conservan las capas, dibujos y movimientos de la cámara para que se puedan util izar 

en Harmony.

 6. En la sección Export Range (Intervalo de exportación), seleccione si desea exportar todo el 

proyecto o solo partes específicas:

 7. Si desea ver los archivos exportados una vez realizada la exportación, active la casilla de 

verificación Open document/folder after export (Abrir documento/carpeta tras exportación).

 8. Haga clic en Export (Exportar).
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